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Course Prerequisites

z IUT 110 Introduction to the IS-U/CCS System

z IUT210 Master Data and Basic Functions

z IUT 220 Device Management

 
 
 

 

 
                                         

 



 

 

 SAP AG 1999

z Audience:
� Project leader

� Project team

� Consultants

z Duration: 2 days

Target Group

 
 
 

User notes 

� These training materials are not a teach-yourself program. They compliment the explanations provided 
by your course instructor. Space is provided on each page for you to note down additional information. 

� There may not be sufficient time during the course to complete all the exercises. The exercises provide 
additional examples that are covered during the course. You can also work through these examples in 
your own time to increase your understanding of the topics. 
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Contents:
Course Goals

Course Objectives

Course Content

Course Overview Diagram

Course Overview
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Get to know SAP EDM

Explain the integration of SAP EDM in IS-U/CCS.

Display the structure and use of the EDM repository

Describe interfaces to and from EDM

Learn how to operate the EDM system

Understand the Customizing settings of the EDM 
system

This course will prepare you to:

Course Goals
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Name the use of EDM by market participants in a 
liberalized energy market
Illustrate how EDM can be used in the energy 
market to manage load profile data.
Discuss the integration of profile management 
into IS-U/CCS.
Explain and set up the point of delivery.
Explain and demonstrate how to create a profile 
header
Demonstrate the Profile Allocation.
Explain and demonstrate profile values 
and the profile import process
Create and use synthetic and formula profiles in EDM

At the conclusion of this course, you will be able to:

Course Objectives
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Unit 6 Profile Allocation

Unit 7 Importing Profile 
Values

Unit 8 Managing Profile 
Values

Unit 9 Formula Profiles

Unit 10 Synthetic Profiles

Unit 1 Course Overview

Unit 2 Introduction to EDM

Unit 3 Overview of the EDM 
functions

Unit 4 EDM Relevant Data 
Objects

Unit 5 Profile Header

Preface

Course Content
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Introduction to EDM: Unit Contents

The need for EDM in the Marketplace

Overview of Profiles

Overview of Complex Billing
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Introduction to EDM: Unit Objectives

z Identify the need for an EDM solution
z Define profiles
z Discuss the components of complex billing.
z Describe the general functions of deregulation.
z Clarify course expectations and recognize 

objectives.

At the conclusion of this unit, you will be able to:
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Energy Marketplace: The Environment

Technological 
changes

Changes to 
customer
demands

IT demandsMarket
changes

Organizational
changes

z Digital interval meters
z Remote meter reading
z Innovative communications: 

power line carrier, 
radio transmission, etc.

z Vertical breakup of integrated
utility companies

z Non-discriminatory grid access
z Privatization
z New market participants

z Fast availability
z Inexpensive implementation
z Investment security
z Interface-free integration

z Low energy prices, price 
transparency

z Individual contract design
z Conditional assumption of

price risks
z Customized service
z Internet use

z Spot markets, futures markets
z Index-based pricing
z Price risks
z Short contract validity periods

 
 
 

� With the recent move to a deregulated market, customers can now not only chose between energy 
providers but also between a wide range of rates, types of contracts, and levels of service. The price of 
energy has become a more important factor. Utilities must now record and analyze increasingly detailed 
information about the consumption and demand of their customers and be able to leverage information 
effectively. 

� Business relationships are also more dynamic in a deregulated environment. Companies require a 
software solution that enables them to exchange vast amounts of data electronically. 

� Deregulation has also given rise to new energy markets, such as the spot market, and new types of 
companies, such as suppliers and distributers. Individual market participants need information that is 
relevant for their business processes. They need a solution that can link processes that were previously 
bundled together within a single company. 
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Transmission company

Customer

Market and Company Changes

Transmission, maintenance, 
removal and safety / guarantee 

of  supply

Transmission, maintenance, 
removal and safety / guarantee 

of  supply

Market, bilateral contracts 
or in-plant generation

Supply contract for
energy, customer service,

and other services

Supply contract for
energy, customer service,

and other services

Customer information, 
load shapes, payment 

consolidation, etc.

Customer information, 
load shapes, payment 

consolidation, etc.
Distribution 

company

Distribution, maintenance, 
removal and safety / guarantee 

of supply

Distribution, maintenance, 
removal and safety / guarantee 

of supply

Supplier

Load shapes,
measured values,

etc.

Load shapes,
measured values,

etc.

Energy 
procurement

 
 
 

� Distributors 

y Maintain meters and measure customer consumption on behalf of suppliers 

y Determine total load shape per supplier 

y Send customer consumption data to supplier, send supplier consumption data to transmission company 

� Transmission System Operators (TSO) 

y Evaluate schedule to determine energy needed 

y Guarantee supply (power system balance) 

y Provide regulation energy to the grid 

y Determine imbalances between load schedule and actual load 

y Reconcile energy imbalances and determine financial credits or debits 

� Suppliers 

y Acquire customers using marketing information and CRM 

y Manage risk 

y Bill customers for consumption, create load forecasts and send them to the TSO 
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z Digital interval meters

z Remote meter reading

z Mass data processing

Technological Changes

Technological 
changes

Changes to 
customer
demands

IT demandsMarket
changes

Organizational
changes

 
 
 

� Technological changes 

y Digital interval meters 

- Measurement values are registered in intervals, such as 5/10/15/30/60 minutes 

- Meters are read locally via serial interface or infrared interface 

y Remote meter reading 

- Meters can also be read remotely by Automated Meter Reading (AMR) Systems 

- Methods of communicating with the meter are, for example, radio communications, telephone lines, 
power line carriers, and so on. 

y Mass data processing 

- A database is needed to store and consolidate data fromAMR systems and interval meters centrally 
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EDM

Energy Data
Repository

Real-Time 
Pricing

Settlement and 
Scheduling

The Three Pillars of EDM
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Target Objectives of Energy Data Management

I. Central Data Repository

III. Settlement

Bills-

R-Us

Joe Smith

2290 West End Rd

Washington DC

Billing period 
May 1 – June 1

KW

60

30

10

Energy Data
Repository

z Historical profiles
z Price profiles
z Forecast profiles

Energy feeding – Energy withdrawal = Balance deviation

II. Complex Billing

Consumption Price Charge
On-Peak kWh

Off-Peak kWh

Spot kWh

Amount Due

100 kWh

400 kWh

100 kWh

$0.25

$0.10

$0.50

$0.25

$0.10

$0.50

$115.00

Additional 
agreement:

Spot delivery

Agreed price

Spot price

 
 
 

� Central Data Repository 

y Stores all types of energy data in the central energy data repository 

� Complex Billing 

y Enables billing of interval data such as real-time pricing and time of use pricing 

� Settlement 

y Processes settlement runs, schedules, and load shapes 
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Introduction to EDM: Overview of Profiles

The Need for EDM in the Marketplace

Overview of Profiles

Overview of Complex Billing
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� What is a profile? 
y Contains values such as consumption and prices for a certain period 
y Within EDM, a profile is composed of header data and profile values 

� Data stored within a profile 
- Historical data: Actual (measured) meter readings 
- Forecast data: Estimated energy consumption or forecast for a customer‘s future usage 
- Schedule data: Proposed energy to be consumed per supplier (aggregation of forecast and/or 

historical data) 
- Conversion factor profile (such as gas law deviation factor) 
- Rate/price/temperature time series 

� Characteristics of a profile 
y Interval lengths (5 minutes, 10 minutes, 15 minutes, 30 minutes, 60 minutes) 
y Unit of measurement (kWh, kW, Price, Temperature, Factors, etc…) 

� Examples of interval data include: 
y Values measured by an interval meter every 60 minutes 
y Forecast values for an interval meter every 60 minutes 
y A price index from the energy exchange with an hourly amount 
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Introduction to EDM: Overview of Complex Billing

The Need for EDM in the Marketplace

Overview of Profiles

Overview of Complex Billing
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What is Complex Billing?

z Within IS-U-EDM, complex billing refers to one or more of 
the following pricing procedures:

Complex 
Billing

SPOT 
Pricing

Real-Time 
Pricing

Time-of-Use 
Pricing

 
 
 

� The following 3 types of complex billing are referred to throughout this unit: 

y Time-of-use pricing 

y Real-time pricing 

y Spot pricing 
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Time-of-Use Pricing

kW
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30
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00:00                                               12:00       24:00       

5. Dec. 2003 6. Dec. 2003

Block 1Block 1
Price APrice A

Block 2
Price B

Block 3Block 3
Price CPrice C

Block 4
Price D

Block 5
Price E

Block 6
Price F

 
 
 

� The Time-of-use prices (TOU prices) for electricity are based on electricity costs during a particular 
period of time. TOU rates are, for example, divided into three time blocks per twenty-four hour period 
(on-peak, mid-peak, off-peak) and by seasons of the year (summer and winter). 

� In a TOU rate structure, higher prices are charged during utility peak-load times. Such rates can provide 
an incentive for consumers to curb power use during peak times. 

� RTP interface handles: 

y Determination of consumption blocks 

y Determination of peak values (i.e. maximum demand) 

� TOU pricing is based on complex time-of-use rate structures which are dependent upon: 

y Seasons, i.e. summer/winter 

y Day types, i.e. working day, public holiday, weekend day 

y Time of the day, i.e. on/off-peak times 

� Time-of-use:  

y Consumption aggregation in every period/time block 

y Price calculation for the quantities 
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TOU Billing

Time-
dependent
limit 2

Quantity A

Time-
dependent
limit 1

Quantity B Quantity C
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KW
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5. Oct. 2000 6. Oct. 2000

rt = 60 min

Agreed price

SpotSpot priceprice

Real-Time Pricing

Measured
load shape

 
 
 

� Real-time pricing is the pricing of energy based on the cost of the energy available for use at the time 
that the customer demands it. 

y New deregulated energy market rules make prices volatile 

y Complex rate structures require the ability for prices to change at up to hourly intervals 

� Real-time pricing: 

y Demand and consumption are amounts that are dependent on each other within each interval. Each 
interval is valuated separately 

y The price is subject to change, which, in extreme cases, can cause it to change in every interval 
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RTP Billing

Consumptio
n-dependent 
limit*

*) Fixed value, profile, ...

Quantity A

Quantity B
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Combination of RTP and TOU Billing

Time-
dependent
limit 1

Time-
dependent
limit 2

Consumptio
n-dependent 
limit*

*) Fixed value, profile, ...
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� The Elspot system price is the SPOT price of energy for the NORDPOOL power exchange.   

� Spot Price: current market price at which short-term energy purchases or sales are made.  

� In a REGULATED market, the price of energy is dependent on: 

y Energy consumption. 

y Demand 

y Voltage, pressure or additional services 

� In a DEREGULATED market, the price of energy is dependent on: 

y Consumption patterns over time 

y Accurate forecasting 

- Energy price is dependent on customer’s willingness to take price risks (“Hedging”) 

� Energy price is the result of consumption, demand, consumption patterns over time, hedging the price 
risk, ... . 

 SAP AG 2003

SPOT Pricing

z Elspot system price for service territory

z Prices shown for March 20 - 27, 2003

27.0320.03

Prices in 
NOK/MWh

$1US ~ 9NOK

1DM ~ 4NOK

http://www.nordpool.com/index.html
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EDM Functional Overview: Unit Contents

Functional Overview of the Energy Data Repository

Profile Data Exchange Within a Deregulated Energy Market

Integration of the Energy Data Repository with IS-U/CCS
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EDM Functional Overview: Unit Objectives

z Describe the functions of the Energy Data Repository
z Describe the integration of electronic data exchange 

with the Energy Data Repository
z Explain the integration of IS-U/CCS and EDM.

At the conclusion of this unit, you will be able to:
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EDM Functional Overview: Functional Overview of 
the Energy Data Repository 

Profile Data Exchange Within a Deregulated Energy Market

Integration of EDM and IS-U/CCS

Functional Overview of the Energy Data Repository
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EDM

Energy Data
Repository

Real-Time 
Pricing

Settlement and 
Scheduling

The Three Pillars of EDM
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� The Energy Data Repository is the central storage database for ALL energy related data needed 
within a utility company, such as prices, weather, conversion factors, and so on. 
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EDM Data

Energy Data Repository

Load 
profile

Meter
reading

Other
profiles

Price
profile

Download
Interval 
meter

Signal

Consumption
meter

MDE

Data
entry Download

Upload

Data entry

Printing

Dataentry

Other energy data

Automated
meter reading

systems

Automated
meter reading

systems

MR
document

Meter
reading
by the

customer

Price data
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Formula calculationFormula calculation

Synthetic load profileSynthetic load profile

Data transferData transfer

Profile billingProfile billing

Profile Management Overview

Profile
Management
Vers

ion

Vers
ion

Calc
ulat

ion

Calc
ulat

ion

Status

Status

Check

Check

Internet Internet 
integrationintegration

Desktop PC Desktop PC 
integrationintegration

DataData
aarchivingrchiving

Data analysisData analysis

 
 
 

� The above diagram gives an overview of Profile Management.   

y The central element is the profile which can store measured values, prices, and other data. 
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Check
consistency of 
profile values

Replacement 
value

procedure

Display profiles

Change/update 
profiles

Import/export
profile values

Allocate
profiles

Save profiles

Profile
Management
Vers

ion

Vers
ion

Calc
ulat

ion

Calc
ulat

ion

Status

Status

Check
Check

Profile Management Elements

 
 
� Save profiles 
y Time basis, interval length 
y Optimized data storage and queries 

� Display profiles 
y In table format 
y In graphics 
y Via OLE interfaces to the local PC 

� Change and update profiles 
y Status monitoring (valid, invalid, manually changed, estimated, and so on) 
y Logging and versioning of changes 
y Automatic estimation and manual creation of schedules 
y Via OLE interfaces to the local PC 

� Import/export profiles 
y From MDE or automated meter reading systems (via BAPI standard interfaces) 
y From third parties via data exchange, such as EDI (IS-U/IDE) 
y Import profile values via BAPIs; IDocs 

� Allocate profiles 
y Via point of delivery ID 

� Check consistency of profiles 
y Consistency checks defined by the enterprise (for example, extreme values, missing values, 

overlapping) 
� Determine replacement values 
y Determination of values during profile value import using the replacement value procedure 
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EDM Functional Overview: Profile Data Exchange Within a 
Deregulated Energy Market

Profile Data Exchange Within a Deregulated Energy Market

Integration of EDM and IS-U/CCS

Functional Overview of the Energy Data Repository
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Data in
proprietary 
format
e.g. ASCII

CCS system
Recipient

EDI translator
Sender

EDI transalator
Recipient

Transmission 
facilities

Data in
proprietary 
format
e.g. ASCII

Data in
standard format
such as EDIFACT, 
ANSI X.12

CCS system
Sender

X400, VAN, leased line, etc.

IS-U
system

Third party
product

Data in
standard format
such as EDIFACT, 
ANSI X.12
System
limitation

System
limitation

SAP IDoc

Electronic Data Interchange (EDI)

E.g. Business
Connector
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XML Data Exchange
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EDM Functional Overview: Integration of EDM and 
IS-U/CCS

EDM Functional Overview

Profile Data Exchange Within a Deregulated Energy Market

Integration of EDM and IS-U/CCS
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Other Applications
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Billing Engine
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� EDM is a fully integrated component of IS-U/CCS. That means you can manage all energy data 
imported from both internal and external enterprises, such as load shapes and profiles, for individual 
points of delivery in one central database. Energy data can be stored and displayed in a variety of 
formats and layouts.  The data can be validated before processing and exporting it to other components, 
such as billing.   

� Energy data can be imported to the EDM Repository from Office Applications such as Excel via OLE 
interface, from AMR systems via BAPIs, from other external systmes via IDocs, and from the Clearing 
house and other external systems via IDE.  

� Once the data has been imported, it is managed within EDM in the form of profiles. 

� The profile information can be passed to IS-U/CCS Billing via the internal RTP-Interface (which will be 
detailed in IUT235). Other IS-U/CCS modules, such as Device Management, Contract A/R and A/P, 
Scheduling, and others, are exported via an internal interface. In the same way, profile data can be sent 
to Customer Relationship Management (CRM) systems and used in customer analyses, marketing 
campaigns, and so on. 

� An extractor will be used to transfer information to the Business Information Warehouse. 
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Integration of the Energy Data Repository in 
IS-U/CCS

IS-U/CCS with EDM
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EDM Relevant Data Objects: Unit Contents

Point of Delivery (PoD)

Data Model Enhancements

New Fields in Device Management
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EDM Relevant Data Objects: Unit Objectives

z Recognize the New Data Model.
z Define Point of Delivery.
z Describe the various PoD elements.
z Explain the different PoD types and roles. 
z Identify PoD customization settings.

At the conclusion of this unit, you will be able to:
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EDM-Relevant Data Objects:
Data Model Enhancements

Data Model Enhancements

Point of Delivery (PoD)

New Fields in Device Management
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� There are five new data objects in the data model as shown above: 

� Point of delivery: Point to which a utility service is supplied or for which a utility service can be 
determined. A point of delivery has one external identifier, a unique number or fixed code, called a Point 
of Delivery ID (will be covered in detail in this unit). 

y A point of delivery serves two roles: 

- Electronic data communication during automatic data exchange (deregulation role) 

- Exchange of measurements (technical role) 

y At one PoD there may be many services attached.  

� Service: A service that is rendered by a service provider at a point of delivery. 

y Note: A PoD services is non-billable.  A contract is a billable service. 

� Service Provider: Company providing a service to a PoD. 

� Profile: Time series data that contains values such as consumption or prices for a certain period.  

� Synthetic Profile: Profile containing values generated on the basis of predefined periods (defined by 
day and day groups) and corresponding day and annual profiles. Synthetic profiles are used for 
classifying customers and customer groups. (See Unit: Synthetic Profile) 

� All data objects are discussed in greater detail throughout the training. 
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Data Model Enhancements

Point of Delivery (PoD)

New Fields in Device Management

EDM-Relevant Data Objects: Point of Delivery
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z Standard PoD
z Virtual PoD

Technical PoD:z Non-billable

z Standard PoD
z Virtual PoD

Deregulation PoD

Point of Delivery Overview

PoD
service

Point
of

delivery

Installation 

Register

PoD
ID

z Metering Code: DE 4711 69190 12345
z Flat structure

 
 
 

The point of delivery is linked with the following objects: 

� Point of Delivery Identification 

� Deregulation point of delivery: 

y Standard point of delivery 

y Virtual point of delivery 

� Technical point of delivery 

y Standard point of delivery 

y Virtual point of delivery 

� Point of delivery service 

y Non-billable services 

 

All of the elements will be covered in detail throughout this unit. 
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� Point of Delivery (PoD): 

y Point to which a utility service is supplied or for which a utility service can be determined. 

y Has one external identifier, a unique number or fixed code, called a point of delivery identification. 

y A point of delivery serves two roles: 

- Electronic data communication during automatic data exchange (Deregulation PoD) 

- Exchange of measurements (Technical PoD) 

y At one PoD there may be many (non-billable) services attached.  

� Examples of PoDs Include: 

y Point from a generation facility to transmission grid 

y Interchange point from a control area’s transmission grid into another control area’s transmission grid 

y Any intermediate measuring point (i.e. a transformer) 

y Point into a customers installation (premise) 
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z Metering Code: DE 4711 69190 12345
z Flat structure

 
 
 

Point of Delivery ID: 

� A unique number or fixed code used to communicate with external systems.  

y The PoD itself, is a unique number created in the system (back office) and the PoD ID is assigned to 
that number.  

� This ID ensures that discrepancies and incorrect allocations of registered data are avoided, with regard to 
the provisioning of information using the utility service determined at a point of delivery, or with regard 
to a change of energy supplier.  

y If the customer changes utility company, the number stays the same. This ensures that data remains 
constant 

� Structure type Metering Code is valid in Germany 

y Other structure types may be customized/defined.   

y Note: The structure type is stored historically and may change over time.   
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There are two PoD Roles.   

The first role is the: 

� Deregulation PoD 

y Automatically generated when an installation is created. 

y Can be allocated to multiple installations 

y Note: Installations must belong to the same division category (i.e. gas, water, electricity, etc.) 

y Can be identified using a PoD ID. 

y Used for communication purposes between different utility companies in a deregulated market. 

 

 

 

 

 
                                         

 



 

© SAP AG IUT225 4-10 

 SAP AG 2003

Point of Delivery Roles: Technical PoD
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The second role is the: 

� Technical PoD 

� Is used in the following cases: 

y You need the point of delivery for technical communication with systems that do not use the usual 
point of delivery ID on the market. 

y You need the point of delivery for technical communication with systems whose measuring system 
does not correspond to market requirements. For example, if a device measures several points of 
delivery.  
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There are two types of PoD: 

� Standard point of delivery 

y A PoD with a physical representation in the energy network. 

y Allocated at register level. 

� Virtual point of delivery 

y Represents a PoD that summarizes or aggregates energy data.  

y Allocated at installation level. 

y Groups together several standard point of delivery categories.  
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Point of Delivery Service 

� A service that is rendered by a service provider at a point of delivery. 

� A PoD service is a non-billable service used only for information purposes. 

y For example, meter reading 

� Note: A billable service corresponds to a contract. 

� All services are allocated to a service type and a service provider.  

y This also enables you to determine whether a proprietary or third party service is used. 

y Services are division-independent 

� Services can be allocated using the move-in/out process as well as through a manual transaction and are 
historically prorated.  
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Customizing Settings: 

� Define PoD Types 

y Standard and Virtual 

y Define PoD types and allocate to predefined categories 

� Define Structure of PoD ID 

y Adjust and enhance structure type 

y Define new structure type 

� Define number ranges for PoD ID 

 Customizing path: SAP Utilities -> Master Data -> PoD 
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Data Model Enhancements

Point of Delivery

New Fields in Device Management

EDM-Relevant Data Objects: 
New Fields in Device Management
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New Fields in Device Management

z Register Group
� New Fields: 

Interval lengths, billing unit of measurement

� Requirements: 
The register code is used to identify the measurement task
The EDIS key figure, for example, can be entered
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 Exercises 

 

 

Unit: EDM-Relevant Data Objects 
Topic: Getting to Know the Data Model 

 

• Find and describe the EDM-relevant data for a business partner. 

• Explain the point of delivery and its characteristics. 

 

 

The company DisCo wants to manage interval meters in IS-U. The 
relevant data objects, such as device type, must be described and defined 
beforehand. Additional data must also be added to the master data model. 

 

1-1 Master data has already been created for business partner TP0101A0## (## represents your 
group number). Display an overview of your contract partner’s key master data. In order to 
answer the following questions, choose Utilities Æ Front-Office/Customer Interaction 
Center Æ Customer Interaction Center from the SAP menu. 

 

1-1-1 Identify business partner TP0101A0## and display the customer environment.  
 
__________________________________________________________ 

 

1-1-2 Display the installed device. Which device category, basic device category, and 
register group are allocated to this meter? 
 

Data Type Value 

Device category  

Basic device category  

Register group  
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1-1-3 Branch to the detailed display of the Register group. What is the register code?  

__________________________________________________________ 
 

Data Type Value 

Register code  

 

What important function does this field perform? 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-1-4 What does the Interval Length field do and which values are permissible for this 
field?  
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

What dependency is created when you enter a permissible value in this field?  
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Return to the Customer Interaction Center.  
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1-2 In addition to the classical technical master data such as connection object and installation, 
the point of delivery fulfils an important task. You are in the Customer Interaction Center.  

 

1-2-1 Display the point of delivery for business partner TP0101A0##. 

 

1-2-2 What are the two possible roles of the point of delivery?  
 

Role 1  

Role 2  

 

What is the difference between these roles? 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Which role does your business partner’s point of delivery have? 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Can a point of delivery be allocated to more than one installation? If yes, which 
prerequisites must be fulfilled? 
 
__________________________________________________________ 
 
__________________________________________________________ 
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1-2-3 Which structure category forms the basis of the point of delivery ID?  
 

Data Type Value 

Structure category  

 

How is the structure category compiled? 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Make a note of your business partner’s point of delivery ID. 
 

Data Type Value 

Point of delivery ID  

 

1-2-4 What is the Customizing path needed to define the structure of the point of 
delivery ID? 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Where can you save default values for this structure? 
 
__________________________________________________________ 
 
__________________________________________________________ 

__________________________________________________________ 
 

 

 
                                         

 



 

© SAP AG IUT225 4-21 

Solutions 

 

 

Unit: EDM-Relevant Data Objects 
Topic: Getting to Know the Data Model 

 

1-1  

 

1-1-1 Identify business partner TP0101A0## and display the customer environment.  

Choose Utilities Industry Æ Customer Service Æ Front Office/Customer 
Interaction Center Æ Customer Interaction Center, or transaction CIC0. Enter 
the business partner number in the Partner field in the search area. Confirm the 
selection by choosing Enter (twice).   

 

1-1-2 Display the installed device. Which device category, basic device category and 
register group are allocated to this meter? 
 

Data Type Value 

Device category TD-INT15-00 

Basic device category Meter 

Register group TP-IN-00 

 

1-1-3 Branch to the detailed display of the Register group. What is the register code?  
 
__________________________________________________________ 
 

Data Type Value 

Register code EDM_TRAINING 

 

What important function does this field perform? 

The register code identifies the meter reading task that is performed on this 
register. In combination with the point of delivery, the register can be used for 
identification purposes. 
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1-1-4 What does the Interval Length field do and which values are permissible for this 
field?  

The field Interval length determines the time intervals between the profile values 
and a profile. The interval length is determined from the allocated interval length 
and the interval length category. 

What dependency is created when you enter a permissible value in this field?  

No meter reading documents are created when you create a meter reading order. 
During meter reading order creation, the installations behave in the same way as 
flat-rate installations.  
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1-2  

 

1-2-1 Display the point of delivery for business partner TP0101A0##. 

In the navigation area of the CIC, go to the Environment tab page and select the 
Installation data object. To display the object, you can either double-click on it or 
select Display Utility Inst. from the context menu (right mouse click). The point 
of delivery is displayed at the bottom of the screen. Choose the FullScrn (Full 
Screen) icon. You will automatically branch to the Display Point of Delivery 
transaction.  
Alternatively, you can access this transaction via the SAP Menu. Choose Utilities 
Industry Æ Technical Master Data Æ Point of Delivery Æ  Display.  

 

1-2-2 What are the two possible roles of the point of delivery?  
 

Role 1 Deregulation point of delivery 

Role 2 Technical point of delivery 

 

What is the difference between these roles? 

The deregulation role is used for electronic data exchange with IDE 
(Intercompany Data Exchange).  

The technical role enables you to exchange meter reading results. 

Which role does your business partner’s point of delivery have? 

The business partner has a deregulation point of delivery. You can see this in the 
Display Point of Delivery transaction. In the work area, select the Alloc. tab page 
and then the Inst. tab page. The Deregulation field is selected. 

Can a point of delivery be allocated to more than one installation? If yes, which 
prerequisites must be fulfilled? 

 

A deregulation point of delivery can be allocated to a variety of installations. The 
following prerequisites must be fulfilled: 

• The installations must be allocated the same division categories (division). 

• The installations must belong to the same premise 

• The installations must have service types that refer to different service 
categories 
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1-2-3 Which structure category forms the basis of the point of delivery ID?  
 

Data Type Value 

Structure category Metering Code Germany 

How is the structure category compiled? 

The constitution of the structure category can vary. It is possible to make 
individual or country-specific adjustments. The metering code for Germany is 
made up of a 33-digit key that is structured in the following way: 

• 2-digit international country identification 

• Max. 6-digit number of the distribution company 

• 5-digit postal code of the area where the point of delivery is located 

• Max. 20-digit unique identification of the point of delivery 

Make a note of your business partner’s point of delivery ID. 
 

Data Type Value 

Point of delivery ID DE 123456 69120 EDM_P_0## 

 

1-2-4 What is the Customizing path needed to define the structure of the point of 
delivery ID? 

From the SAP menu, choose Tools Æ Customizing Æ IMG Æ Project 
Management. In the SAP reference IMG choose SAP Utilities Æ Master Data Æ 
Point of Delivery Æ Define Structure of Point of Delivery ID.  

Where can you save default values for a structure? 

Choose an item (Structure) in this activity and select Field Settings. 
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Profile Header: Unit Contents

Profile Header

Profile Types and Profile Categories

Create Profile Header
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Profile Header: Unit Objectives

z Define and use profile headers.
z Explain and use profile header data.
z Understand the difference between profile 

headers and profile values.
z Describe profile types.
z Describe profile categories.
z Create a profile header.

At the conclusion of this unit, you will be able to:
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EDM Profile Creation Process
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� The profile creation process within EDM is referred to throughout the IUT225 course in Units 5, 6, 7 and 
8.   

� The first step in this process is creating the profile header. 

� The profile header data sets the characteristics of the profile. The allocation process allocates the profile 
header to the profile values. The profile header must be created before the profile can be allocated to an 
object within the system. The profile values can then be imported and managed within the system. 
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� Profile header – defines the profile values stored in the profile 

� Division:  Company-internal key for the division category that is predefined by the Utilities Industry (IS-
U) component. 

� Status: 

y Defines the status of the profile based on standard SAP status 

y The different kinds of current status include active/usable, inactive, allocated/deletion flag set 

y Customer-defined statuses are possible 

� Profile type:  Describes the type of data stored in the profile.  Can be adjusted to meet the requirements 
of business processes 

� Validity date: Date from/to which the profile is valid 

� Profile value category: Sets the category of the profile values, this includes, amount, factor, quantity, 
demand, price, other 

� Date when profile values are archived: This field contains the date up to which the archiving has 
occurred. 
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� Profile header – defines the profile values stored in the profile 

� Interval length: Interval between two values in a profile (for example 5, 10, 15, 30, 60 minutes) 

� Currency: Specifies the currency for the profile values (for example Euro or US Dollar for a price 
profile). 

� Unit of measurement:  Unit of measurement for the consumption values (for example kW, kWh, mWh,).  

� Decimal places:  Number of decimal places to be stored for the profile values.  

� Data storage format: 

 Cumulative values: Indicates that at a time t, the value is dependent of the values of t-n. Generally this is 
not the case with an interval meter. 

� Note:  The following elements of the header data will be discussed in unit Profile Import: Consistency 
checks, replacement value group, reference profile and authorization group. 
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Data Storage Format - Cumulative Values

100kWH

203kWh

403kWH

EDM DisplayMeter Value

100kWH

103kWh

200kWH

100kWH

103kWh

200kWH

EDM DisplayMeter Value

100kWH

103kWh

200kWH

 
 
 

� The Cumulative Values Checkbox on the profile header is used in the following manner. 

y If checked, the meter read value for each interval is added to the previous intervals measured value (as 
shown above in the first example) 

y If not checked, the meter value is the same as the value displayed in EDM (typical for interval meters) 
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� The profile header is used in order to save database storage space. The profile header contains 
characteristics of the profile values. If these characteristics were stored at interval level, a very large 
amount of data storage space would be needed. The concept of the profile header allows the interval data 
values to be stored and archived in an efficient manner. If profile values are archived, the profile header 
remains in the system as a link to the archived profile values. 
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� Profile categories: 

y Characterize the profile type 

y Are predefined by SAP 

y Are not customizable 

� There are five predefined profile categories: 

y Elementary:  Contains values that are imported or entered manually 

y Synthetic: Contains values that were created for a customer group. These values can be grouped 
together according to season, time of day or day type.  

y Formula:  Contains values calculated using a predefined formula and using other profiles. For 
example, you can use a formula profile to calculate the energy feeding curve of the grid. 

y Day:  Contains values that are measured at identical intervals and that, together, describe one day.  
Day profiles are allocated to synthetic profiles to reproduce the consumption of one day such as a 
weekend day in summer or a weekday in winter.  

y Integral: Only used internally within the system 
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� There are two important elements of the header data: 

y Profile categories 

y Profile types: 

� The above mentioned profile types are provided in initial customizing (historical, forecast, etc.).  Further 
profile types can be customized by the customer. 

� When new profile types are created, they are allocated to  profile categories, which are predefined by 
SAP. 
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� Profile types: 

y Are customizable based on business process 

y Are stored within the profile header data 

y Are assigned to a profile category 

� Profile types are defined and allocated to a profile category in Customizing. 

� Customizing path:  IMG -> SAP Utilities -> Energy Data Management -> Basic Settings -> Profile 
Type: 

y Define profile types 

- Description (fee choice of text to describe the profile type) 

- Profile category (elementary, synthetic, formula, day) 

- Profile history (historical, schedule, forecast) – used for information only 

y Define permissiblity of interval lengths per profile type 

- For each new profile type, define the permissible interval lengths (5, 10, 15, 30, 60) 

� For more information on Customizing, see the EDM Basic Customizing Settings Cookbook on the 
Utilities homepage in SAPnet 
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Profile Header: Create Profile Header
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� Definable options: 

y Status 

y Profile types (see slide above for sample of a Customized profile type) 

y Interval lengths: 

- Customizing path:  IMG -> SAP Utilities -> Tools -> System Modifications -> User-defined 
Enhancements for EDM -> Interval Lengths 

y Consistency check groups (see unit on Importing Profiles) 

y Replacement value procedure groups (see unit on importing profiles) 

� Details within the profile header can be maintained for the synthetic and formula profiles (see unit on 
Synthetic & Formula Profiles) 

� The system automatically assigns a profile number if you have already defined number ranges in 
Customizing (see the Cookbook Profile Management Customizing) 
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Exercises 

 

 

Unit: Profile Header 
Topic: Create Profile Header 

 

At the conclusion of this exercise, you will be able to: 

• Create a profile header 

 

 

The company DisCo would like to implement Profile Management. To do 
this, different profiles must be created so that data entered with an 
interval meter can be read, for example.  

 

1-1 EDM profiles are processed in several steps. In the first step, the basic characteristics are 
created in the profile header.  

 

1-1-1 Name three important characteristics that are recorded in the header data of a 
profile. 
 
_______________________________________________________ 
 
_______________________________________________________ 
 
_______________________________________________________ 

 

What does the profile header do? 
 
_______________________________________________________ 
 
_______________________________________________________ 

 

Can meter reading values be treated differently (here data storage format)? 
 
_______________________________________________________ 
 
_______________________________________________________ 
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1-1-2 How many different kinds of profile categories can you name and where are they 
indirectly stored in the profile header? 
 
_______________________________________________________ 
 
_______________________________________________________ 
 
_______________________________________________________ 
 
_______________________________________________________ 
 
_______________________________________________________ 
 
_______________________________________________________ 

 

Can customer-specific profile categories also be created? 
 
_______________________________________________________ 
 
_______________________________________________________ 

 

1-1-3 Create a new profile header to manage measured profile values from the division 
Electricity. Enter the following data:  
Profile description: TP0101A0## Measured Consumption  
Division:  Electricity 

In the General tab page, select the following entries in the Profile Data section 
box: 
Profile type: Historical Profile 
Cons. check group Checks for Status of Profile Values 
Valid from: 01.01.2001 
Valid to:  31.12.9999 

In the Value Data section box, select the following entries: 
PV category:  QUANTITY  
MeasUnit for MR:  kWh 
Interval length:  15 Minutes 
Decimal places:  7 

Save your entries and make a note of the profile number. 

____________________________ 
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Solutions 

 

 

Unit: Profile Header 
Topic: Create Profile Header 

 

1-1 EDM profiles are processed in several steps. In the first step, the basic characteristics are 
created in the profile header.  

 

1-1-1 Name three important characteristics that are recorded in the header data of a 
profile. 

Interval length 
Interval between the profile values of a profile.  

Profile type 
User-defined form of the profile category predefined by SAP. 

Profile value category 
The profile value category is predefined and characterizes the profile values that 
are allocated to a profile header. For example: Quantity, demand, price, amount, 
factor, or other.  

What does the profile header do? 

The profile header is used to save database storage space. The characteristics in 
the profile header are transferred to the profile values. 

Can meter reading values be treated differently (here data storage format)? 

Yes. You can activate the Accumulated Value indicator.  
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1-1-2 How many different kinds of profile categories can you name and where are they 
indirectly stored in the profile header? 

Elementary profile: 
Profile containing values that have been imported or entered manually. 
Synthetic profile: 
Profile containing values generated on the basis of predefined periods (defined by 
day and season groups) and corresponding day or annual profiles. 
Formula profile:  
Profile containing values calculated using a formula. 
Day Profile: 
Profile containing values measured at identical intervals and that, together, make 
up one day. 
Integral Profiles: 
Profile calculated from a synthetic profile by adding together individual 
consumption values. 

You allocate the profile type to a profile category in Customizing. The profile 
type is entered in the profile header. Several profile types can be allocated to one 
profile category. 

Can customer-specific profile categories also be created? 

No. Profile categories are predefined by SAP. You can, however, define 
customer-specific profile types that are then allocated to the profile categories. 

 

1-1-3 From the SAP menu choose Utilities Æ Energy Data Management Æ Profile 
Management Æ Profile HeaderÆ Create or transaction EEDM06. Enter the data 
provided in the exercise. 
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Profile Allocation: Unit Contents

Allocating Profiles to IS-U/CCS Objects

Profile Roles

Role Category

Profile Allocation Process
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Profile Allocation: Unit Objectives

z Recognize the IS-U/CCS objects to which a 
Profile can be allocated.

z Explain Profile Roles.
z Describe Profile Role Categories.
z Customize Profile Roles.
z Allocate a Profile.

At the conclusion of this unit, you will be able to:
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Profile Allocation: Allocating Profiles to IS-U/CCS 
Objects
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Role Category

Profile Allocation Process
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EDM Profile Creation Process
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z Modify

z Version

z kWh Measured

z Price Profile

z Network Losses

 
 
 

� The profile creation process within EDM is referred to throughout the IUT225 course in units 5, 6, 7 and 
8.   

� The first step in this process is creating the Profile Header. This was previously discussed in unit 5. 

� Now that the profile has been created (via the Create Profile Header process), the profile must be 
allocated to an entity within the system. 

� In this unit, profile allocation will be discussed. The allocation of a profile simply attaches the Profile 
Header to a data object within IS-U/CCS. These two steps allow the actual profile values  
(i.e. raw usage data) to be imported into the system. 
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Profile Allocation: Profile Roles

Allocating Profiles to IS-U/CCS Objects

Profile Roles

Role Category

Profile Allocation Process
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Profile Roles
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� The role determines which task this profile carries out on the register. 

� Profile roles are used for the following: 

y Import and export of profile values 

y The profile of the data to be processed is identified using the point of delivery, the point of delivery 
register code and the role category. 

y In real time pricing (RTP) billing, roles enable the flexible allocation of profiles to input parameters 
from the RTP interface 

y In the RTP rate, the role replaces the register operand as the source of consumption data 

y In replacement value creation, the role determines the reference profile 

y In settlement processing, roles identify settlement parameters 
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Profile 101

Profile 102

Profile 103

Billing -> Register -> Role -> Profile

Profile Changes

 
 
 

� The profile is allocated to the register in time slices via the role. 

� For example: 

y A customer (this means the register) is initially allocated profile 101 via the consumption measured 
role. 

y On the January 08, 2001, the customer is allocated a new measured profile with the number 102. 

y Another change is needed on January 19, 2001. As a result the customer is allocated profile 103.  

y All profiles are maintained in the system. In the billing period January 01 2001 - January 31 2001, the 
following profiles are processed according to time slices via billing: 

- 101 Consumption measured from 01/01/2001 – 01/08/2001 

- 102 Consumption measured from 01/08/2001 -01/18/2001 

- 103 Consumption measured from 01/19/2001 – 01/31/2001 

 

 
                                         

 



 

© SAP AG IUT225 6-9 

 SAP AG 2003

Role Allocation
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� The following are example profile roles provided as standard in Customizing: 

y Consumption measured  

y Consumption forecast  

y Agreed demand 

y Price profile 

y Agreed consumption 

y Agreed consumption  
On-peak rate 

y Agreed Consumption  
Off-peak rate 

y You can define other profile roles in Customizing. 
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Profile Allocation: Role Category

Allocating Profiles to IS-U/CCS Objects
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� Roles: Refer to the profile from which values are to be used 

y Some roles are defined by SAP. You can define further roles in Customizing (see Customizing: SAP 
Utilities -> Energy data management -> Profile management -> Define roles for profile allocation) 

� There are four role categories defined by SAP: 

y Measurement: Profiles allocated to this role category describe consumption measured by an interval 
meter. You can only allocate one profile with this role category to a register. When profile values are 
imported using the point of delivery and its register code, this role category is used to identify the 
profile into which these values are to be imported. 

y Forecast: Profiles allocated to this role category describe the consumption forecast for the interval 
meter. You can only allocate one profile with this role category to an interval meter. The frequency of 
the roles in this category must always be 1. The forecast is used by the system operator for the 
procurement schedule. 

y Settlement: Profiles allocated to the role category settlement are included in the settlement process. 
Only one profile with a role in this category can be allocated to a register or an installation. 

y Not specified: Use this category for roles with unspecified functions 
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� You can define roles and allocate them to role categories defined by SAP  
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� In Customizing, select SAP Utilities -> Energy Data Management -> Profile Management -> Define 
Roles for Profile Allocation. 

y Role: Identification for the role of a profile allocation  

y Role description: Text describing the role of a profile allocation 

y Frequency (Frequency of allocation per role): Number that indicates how often a profile with a certain 
role may be allocated to an interval meter. You must specify 1 for the frequency of roles in role 
category Measurement or Forecast 

y Role category:  Category to which the role has been allocated 

� Roles to be used are defined in Customizing and allocated to profile categories predefined by SAP 

� For more information about Customizing, see the Basic Customizing Settings Cookbook. 
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Profile Allocation - Register (Profile View)

z EDM -> Profile Management -> Profile Allocation -> Change
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profileprofile Insert row
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data

 
 
 

� There are two system views by which the profile can be allocated: 

y Register view:  Search by any of the following to drill down to the register: 

- Business partner 

- Contract account 

- Contract 

- Installation  

y Profile view:  Search by the profile to allocate 

� Note that from the profile view: 

y Profile data is shown in the upper right side of the screen 
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Profile Allocation - Register (Register View)

z EDM -> Profile Management -> Profile Allocation -> Change

EnterEnter
businessbusiness partnerpartner, , 
contract accountcontract account, , 

contractcontract, , oror
installationinstallation

SelectSelect
rolerole

SelectSelect
registerregister Insert row

Enter validEnter valid
date/timedate/time

SelectSelect
profileprofile Save data

 
 
 

� There are two system views by which the profile can be allocated: 

y Register riew:  Search by any of the following to drill down to the register: 

- Business partner 

- Contract account 

- Contract 

- Installation  

y Profile view:  Search by the profile to allocate 

� Note that from the register view: 

y Register data is shown in the upper right side of the screen 
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Exercises 

 

 

Unit: Profile Allocation 
Topic: Allocate a Profile to a Register 

 

At the conclusion of this exercise, you will be able to: 

• Allocate a profile to a register via the profile view 

1. Allocate a profile to a register via the register view 

Note: 

When the data was set up, only one register was created for each device. 
Nevertheless, you can still allocate profiles in different ways:  
One participant allocates the profile to the register via the profile view 
while the other allocates the profile to the register via the register view.  

 

1-1 Once the profile header has been created, it must be allocated to IS-U data objects. You 
can do this in two ways. Choose either task 1-2 or 1-3 to allocate a profile. 

 

1-1-1 Can synthetic profiles be allocated to registers?  
 
__________________________________________________________ 

 

1-1-2 Roles are needed for profile allocation. In the Customizing menu for SAP 
Utilities, find the activity where you maintain the roles for profile allocation. 
What is the path in Customizing? 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-1-3 Which role categories are predefined?  
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 
 
__________________________________________________________ 
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1-2 In the SAP menu choose Utilities IndustryÆ Energy Data Management Æ Profile 
Management Æ Profile Allocation Æ Change. In the Prof. tab page, enter the profile 
number that you created previously. Select 01/01/01 as the selection date. 

 

1-2-1 Display the profile. Describe how you do this? 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-2-2 First of all, allocate the Consumption Measured role to your profile.  
 
__________________________________________________________ 
 
__________________________________________________________ 

 

Allocate the first register of device TP0101A0## to your profile starting from 
01/01/01. 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-2-2 Save your entries. Alternatively, you can allocate the profile from the register 
view in the following exercise.  
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1-3 In this exercise, you allocate a profile to a register via the register view. (Note: If you have 
already carried out the profile allocation in exercise 1-2, you can no longer execute this 
exercise). 

 

1-3-1 In the SAP menu choose Utilities IndustryÆ Energy Data Management Æ 
Profile Management Æ Profile Allocation Æ Change. Enter 01/01/01 in the 
Selection Date field. In the selection area (tab page BP), enter the business 
partner, the contract account, the contract, or the installation number of business 
partner TP0101A0## and choose Enter.  
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-3-2 Enter the number of the profile that you created in the Profile Header exercise 
 
__________________________________________________________ 
 
__________________________________________________________ 

 

1-3-3 Save your entries. 
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 Solutions 

 

 

Unit: Profile Allocation 
Topic: Allocate a Profile to a Register 

 

1-1  

 

1-1-1 Can synthetic profiles be allocated to registers?  

No. Amongst other things, synthetic profiles represent customer groups. Synthetic 
profiles are allocated to installations.  

 

1-1-2 Roles are needed for profile allocation. In the Customizing menu for SAP 
Utilities, find the Customizing activity for maintaining the roles for profile 
allocation. What is the path in Customizing? 

In Customizing for SAP Utilities choose Energy Data Management Æ Profile 
Management Æ Define Roles for Profile Allocation. 

 

1-1-3 Which role categories are predefined?  

Measurement: 
Profiles with this role category describe the consumption measured by an interval 
meter. 

Forecast 
Profiles with this role category describe the consumption forecast by an interval 
meter.  

Settlement: 
Profiles allocated to this role category are included in the settlement process. 

Not specified:  
Profiles that do not have a specified function are allocated the Not Specified role 
category.   
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1-2 In the SAP menu choose Utilities IndustryÆ Energy Data Management Æ Profile 
Management Æ Profile Allocation Æ Change. In the Prof. tab page, enter the profile 
number that you created previously. Choose 01/01/01 as the selection date. 

 

1-2-1 Display the profile. Describe how you do this? 
Once you have entered the profile number and the selection date in the selection 
area, choose Enter. The search results are displayed in the navigation area. The 
result is the profile number. You can display the relevant data in the work area by 
double clicking on the profile number. You can also display the result using the 
right mouse button and selecting Display from the context menu. In the following 
process, make sure you know which objects are in the navigation area.  

 

1-2-2 First of all, allocate the Consumption Measured role to your profile. 
The Role field is blank. Select Consumption Measured from the list. 

Allocate the first register of device TP0101A0## to the profile starting from 
01/01/01. 

Choose the Insert Line icon, or in the menu bar choose Edit Æ Table Entries Æ 
Insert Line. Make a note of the From-Date. It should be 01/01/01. 
In the Device column, enter device number TP0101A0## and in the Register 
column, enter 1. 

 

1-2-2 Save your entries. Alternatively, you can allocate the profile from the register 
view in the following exercise.  
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1-3 In this exercise, you allocate a profile to a register via the register view. (Note: If you have 
already carried out the profile allocation in exercise 1-2, you can no longer execute this 
exercise). 

 

1-3-1 In the SAP menu choose Utilities IndustryÆ Energy Data Management Æ 
Profile Management Æ Profile Allocation Æ Change. Enter 01/01/01 in the 
Selection Date field. In the selection area (tab page BP), enter either the business 
partner, the contract account, the contract, or the installation number of business 
partner TP0101A0## and choose Enter. All of the data objects are displayed in 
the navigation area. Double click on the Register to display register and 
installation data in the work area. 

 

1-3-2 To allocate the profile, enter the number of the profile that you created in the 
Profile Header exercise. 

To display the profile header, double click on the profile number.  

 

1-3-3 Save your entries. 

The allocated profile is displayed in the navigation area. 
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Import Profile Values: Unit Contents

Profile Import

Import Monitoring

Consistency Checks and Groups

Replacement Value Procedures and Groups
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Import Profile Values: Unit Objectives

z Explain the import interfaces of profile values 
via IDoc and BAPI interfaces

z Import profile values
z Operate the import monitoring function.
z Explain the consistency checks
z Use the possibilities provided by 

replacement value creation

At the conclusion of this unit, you will be able to:
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EDM Profile Creation Process

Unit 5 Unit 7Unit 6 Unit 8

Profile header Profile 
allocation

Import 
profile 
values

Manage 
profile 
values

Header data Role allocation Inspection Management

z Interval length

z Division

z Status

z Profile type

z Monitoring

z Consistency 
check Code

z Replacement 
value

z Search

z Display

z Modify

z Version

z kWh measured

z Price profile

z Grid losses

 
 
 

� The profile creation process within EDM is described in Units 5, 6, 7  and 8 of the IUT225 course.   

� The first step in this process is creating the profile header. This was discussed in Unit 5 – Profile Header. 
The second step, profile allocation, was described in Unit 6. 

� Once the profile has been created (via the create profile header process) and allocated to an object within 
the system (via the allocate profile process), the profile values must be imported into the system.    
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� Profile values can be imported using two procedures 

y BAPIs (Business Application Programming Interface): Importing measurement data via a 
synchronous communication path (for example, a function call such as RFC).  

y Idocs (Intermediate Document): Importing data via an asynchronous communication path (for 
example, electronic data exchange). 
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Data Model Elements Used to Import Profile Values

Business
partner

Contract
account

Contract

Connection 
object

Premise

Installation 

Device 4711
--> Register 1

PM/MM

logDevice 10023678
--> logReg 30976230
<Code: EDM_TEST 1>

Device
location

Connection 
object

Profile 7649874

PoD   DE2367093PoD   DE2367093

BAPI ISUPROFILE.Upload

<Role: Profile role category = measurement>

<Profile role type: measured consumption>

DE2367093  EDM_TEST 1  01  0001  20000101001500+1 20000101003000+1 9.02000000000000 ...
DE2367093  EDM_TEST 1  01  0001  20000101003000+1 20000101004500+1 9.25000000000000 ...
DE2367093  EDM_TEST 1  01  0001  20000101004500+1 20000101010000+1 9.82000000000000 ...
DE2367093  EDM_TEST 1  01  0001  20000101010000+1 20000101011500+1 9.06000000000000 ...
...

 
 
 

 

� During data import, registers are identified by the following objects: 

y Point of delivery identification 

- For example, DE2367093 

y Register code 

- For example, EDM_TEST 1 

y Role category of a profile allocation 

- For example, measurement (=01) 

y Role of a profile allocation 

- For example, consumption measured (=0001) 
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Example for Import Profile Values Transaction

z [EEDMIMP01]

EnterEnter
transaction transaction 

codecode

EnterEnter
externalexternal

referencereference
(if applicable)(if applicable)

SelectSelect
file typefile type

Enter file
location

Open fileOpen file

Data is imported 
and confirmed

 
 
 

� The transaction code for the Import Profile Values Process is:  [EEDMIMP01] 

� The following file types are available for profile value import: 

y ASC: ASCII 

y BIN:  Binary 

y DBF: DBASE format 

y IBM: ASCII with IBM code page conversion (DOS) 

y WK1: Spreadsheet format 

y DAT: ASCII data table with column tab 

Enter external reference 

Enter the path for the import file 

� Once the import process is complete, you can view the import status using a transaction.  A message is 
sent informing the user whether or not the import was successful.  For more information about the 
import, choose the "Monitor Profile Import" transaction. Use the path Utilities -> Energy Data 
Management -> Monitoring -> Profile Value Import [EDM1]. 
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Import Profile Values Using a BAPI

ISUPROFILE.Upload ISUPROFILE.Import

 
 
 

� ISUPROFILE. Upload 

y You can import the profile values using this BAPI. 

� ISUPROFILE. Import 

y You can also import profile values using this BAPI. 

y You can also specify the role and the role category to register determination. 
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Export Profile Values Using a BAPI

ISUPROFILE.Get ISUPROFILE.GetfromPoD

 
 
 

� ISUPROFILE.Get 

y You can export profile values from the Energy Data Repository using this BAPI. 

� ISUPROFILE.GetfromPoD 

y You can also export profile values from the Energy Data Repository using this BAPI. Here though, 
you can specify additional selection categories such as point of delivery, point of delivery ID, role and 
role category. 
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Import Profile Values: Import Monitoring
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Replacement Value Procedures (RVP) and RVP Groups
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� A import log is created once the import transaction has been completed. To display profile values, go to 
the Utilities Industry menu and choose Energy Data Management -> Monitoring -> Import Profile 
Values [EDM1]. 
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Validity dates of profile values
Validity periods of profile values
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Import Profile Values: Consistency Checks and 
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Profile Import
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Consistency Checks and Groups: Examples

Time from Time to
00:00:00
00:00:00
00:15:00
00:30:00
01:00:00
01:15:00
01:30:00
02:00:00

00:14:59
00:14:59
00:29:59
00:44:59
01:14:59
01:29:59
01:44:59
02:14:59

Values
10.000
10.000

9.000
10.200

5.020
10.010
11.000

7.014

Time from Time to
00:00:00
00:15:00
00:30:00
01:00:00
01:15:00
01:30:00
02:00:00

00:14:59
00:29:59
00:44:59
01:14:59
01:29:59
01:44:59
02:14:59

Values
10.000

100.000
10.200

5.020
10.010
11.000

7.014

Time from Time to
00:00:00
00:15:00
00:30:00
01:00:00
01:15:00
01:30:00
02:00:00

00:14:59
00:29:59
00:44:59
01:14:59
01:29:59
01:44:59
02:14:59

Values
10.000

9.000
10.200

10.010
11.000

7.014

Overlapping 
values

Out of range 
values

Missing values
Check for 

out of range 
values

Check for 
overlapping 

values

Check for 
missing values

 
 
 

� Consistency checks check the profile values as they are imported into the system. Example: 

y Missing and overlapping value consistency checks are allocated to consistency check groups. 

y Consistency check groups are allocated in the profile header (see unit 4). 
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Consistency Check Groups

Value 
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lapping

Missing
values

Out-of-
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Consistency 
check group 1

Consistency 
check group 3Consistency 

check group 2

 
 
 

� The example above shows four consistency check groups to which the following consistency checks are 
allocated: 

y Consistency check group 1: carries out the following check during profile import: 

- Overlapping Values 

y Consistency check group 2: carries out the following 2 checks during profile import: 

- Missing values, out-of-range values 

y Consistency check group 3: carries out the following 3 checks during profile import: 

- Overlapping values, missing values, out-of-range values 
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= Error information 

 
 
 

� Customizing path: -> SAP Utilities -> Energy Data Management -> Interface to External Systems  
-> Import Check. 

y Define consistency checks for profile import 
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Import Profile Values: Replacement Value 
Procedures (RVP) and RVP Groups

Profile Import

Import Monitoring

Consistency Checks and Consistency Check Groups

Replacement Value Procedures (RVP) and RVP Groups
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ExtrapolateExtrapolate

Replacement Values Defined

 
 
 

� The replacement value process creates profile values that are used to replace missing values. 

� The replacement value process is used for the following reasons: 

y Profile values do not exist for a certain time period (for example, due to a device breaking down or 
communication error). 

y To perform billing simulations for future time periods or for the creation of forecast schedules. 

� Within Customizing, the replacement value procedures are first of all defined.  These replacement value 
procedures are then assigned to replacement value groups. Replacement value groups are assigned to a 
profile (in the profile header).  This defines the replacement value procedures that are to be used to 
generate values for the assigned profile. 

� The replacement value group can be changed in the profile header after the profile header has been 
created. 

� Only the intervals with missing values are replaced, for example, if some intervals have values and 
others do not, the existing values are not overwritten. 

� It is only possible to generate replacement values for values with the status value does not exist.  If the 
value is 0.00 but has a valid status, the value will NOT be replaced.   

� It is possible to delete values with the statuses manually changed/extrapolated/interpolated using the 
Modify Profile Values transaction, so that replacement values can be regenerated for these intervals. 
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� Replacement value procedures are defined using the following input parameters: 

y Reference time period 

y Reference profile 

y Reference profile role 

y Historical values: a time period is defined and historical values are taken from this period.  These 
values can come from either a profile that requires values or from another profile (reference profile). 

� Error codes are defined for each replacement value procedure. These define all possible errors that can 
result from the procedures (for example, no historical data in the period required). 

� These replacement value procedures are allocated to replacement value groups. 
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� Replacement values are generated in the following scenarios: 

y Automatic interpolation during value import. You can activate the automatic interpolation of profile 
values during profile import. The procedures can also be activated from the Monitor Import of Profile 
Values screen (Menu -> Edit -> Generate Replacement Values). 

� Manual replacement of missing values using the profile values transaction. 

� Interpolation and extrapolation can be executed using Mass changes in the profile values 
transaction.   

� Automatic extrapolation during billing simulation. 

� In the context of IS-U Billing, it is now possible for interval customers to execute a billing 
simulation based on the extrapolated profile values. 

- Replacement values can only be generated for the profile categories consumption or demand. 
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� Seven predefined SAP replacement value procedures can be used: For profiles with only small amounts 
of data missing, values can be determined from the immediate environment (this means, the value before 
and after the missing values) 

� Linear replacement value procedure: The difference between the last known value before the missing 
values and the first known value after the missing value is distibuted across the total number of missing 
intervals.  

� Maximum value replacement procedure: The missing values are replaced with the maximum value from 
the last known value before the missing values and the first known value after the missing values. 

� Minimum value replacement procedure: The missing values are replaced with the minimum value from 
the last known value before the missing values and the first known value after the missing values. 
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� CONTROL: Copy values from the profile of control meter 
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� Different replacement value procedures can be allocated to a replacement value procedure group.. 

� The replacement value procedures in a replacement value procedure group are prioritized, the 
replacement value procedure with the highest priority is called first. If this replacement value procedure 
cannot replace the missing values (for example, due to missing environment data/data missing from a 
control meter), the replacement value procedure with the next highest priority is called. 

� The replacement value procedures in a replacement value procedure group are valid for a certain number 
of missing values. 

� If, for example, the number of values to replace lies between 1 and 3, the corresponding replacement 
values are generated using replacement value procedure x. 
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� The following parameters define replacement value procedures: 

y Replacement value procedure (mandatory) 

y Function module for replacement value creation (mandatory): Replacement value procedures are 
implemented as function modules. Each replacement value procedure is allocated to a function module 
that executes replacement value creation. All function modules that are entered here must have the 
same interface as function module ISU_EDM_REP_METH_LINEAR. 

y Function module for determination of reference period: This function module is called during the 
replacement value procedure and determines reference periods for the profile such as seasons, day 
groups and TOU groups.  The function module provided by the customer allocates the profile from the 
RTP interface to the replacement procedure.  An interface is defined in the sample function module:  
ISU_EDM_REF_TIME_SAMPLE. 

y Reference profile:  This is a reference profile for the replacement value procedure. 

y Reference profile role: This is a reference profile role for the replacement value procedure. You can 
allocate reference profiles indirectly using roles. At the time of procedure execution, the profile that is 
allocated to the interval meter with the specified role, is transferred to the replacement values 
procedure. 
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y Start of reference period:  If the procedure is based on a historical profile, the values used come from 
the start of this reference period (yesterday, last week, last month, and so on). 

y Duration of reference period 

y Reference period corresponds to replacement period:  If you select this field, the duration of the 
reference period corresponds to the duration of the replacement period.  If you select this field, entries 
in the field Duration of Reference Period do not take effect. 

y Replacement value procedure valid for consumption/demand profiles:  Every Procedure must be valid 
for either consumption profiles or demand profiles or both. 

y Procedure valid for interpolation/ extrapolation of profile values: Every Procedure must be valid for 
interpolation or extrapolation or both. 

y Manual entries required for replacement value procedure: If you select this field, this replacement 
value procedure cannot be used with profile value import or billing simulation.  

y Description of replacement value procedure 

y Error codes for replacement value procedure: Defines the possible types of error that can occur when 
replacement values are created. 
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� Each replacement value procedure group contains interpolation and/or extrapolation processes. The 
following parameters define replacement value procedure groups: 

y Definition of replacement value procedure group 

- Replacement value procedure group after profile value import: The procedure group is 
automatically called if the system determines that values are missing after a profile value import. 

- Replacement value procedure group valid for consumption/demand profiles: Every procedure group 
must be valid for either consumption profiles or demand profiles or both. 

- Description of replacement value procedure group 

y Allocation of replacement value procedure to group 

- Replacement value process: Interpolation or extrapolation of profile values 

- Priority of replacement value procedure(RVP) in RVP group: This field defines the priority of a 
replacement value procedure in a replacement value procedure group. The replacement value 
procedure with the highest priority is always called first. 

- Minimum/maximum number of values: Min/Max number of values that can be replaced using values 
from this procedure.  

- Replacement value procedure 
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� Errors codes are defined for replacement value procedures according to process 

y Description of Error Code for Replacement Value Procedure: This field describes the types of errors 
that may appear during replacement value creation. 

y Actions for Error Codes for Replacement Value Procedures.   

 Exit Processing, do not save values 

 Exit Processing, save values (this means, save all values – even if only half of the values were 
generated) 

 Continue processing, delete values (should not be used if there are no more procedures because the 
last known values are always saved and these could potentially all be zero) 

 Continue processing, use values (should not be used if there are no more procudures because the last 
known values are always saved and these could potentially all be zero) 
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Exercises 

 

 

Unit: Import Profile Values 
Topic: Import Profile Values 

 

At the conclusion of this exercise, you will be able to: 

• Import profile values 

 

 

Your business partner TP0101A0## has a measured load shape for the 
period January to April 2001. You must import these values to your profile 
and monitor the profile value import.  

After this, you must create a forecast profile and import forecast values for 
the month of June.  

Some forecast values are missing. You must create the replacement values 
manually. 

You then import the values for the month of May into the profile that 
already contains the interval values. The missing values for May are 
corrected automatically. 

Finally, you will use the forecast profile for one day in June for 
extrapolation. 

Note: Before importing profile values you must download the import file to 
your local hard drive.  Follow the steps below to execute this transaction. 
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1-1 In order to download the import data, choose the following path in the SAP menu: Utilities 
Industry Æ Business Master Data Æ Business Partner Æ Contract Partner Æ Display. 

 

1-1-1 Enter Business Partner TP0101A0##. Select Enter and in the menu bar choose 
Extras → Documents. Display the input file by double clicking on the file name. 

Compare the PoD, the unit of measurement, and the register code with the values 
you made a note of in the EDM-Relevant Data Objects exercise. 
 

Field name or data type Values 

Point of delivery  

Unit of measurement  

Register code  

Close the file. 

Under Text, select the file name and choose the Export Document icon. 

Do this for the following files: 
EDM_TRAINING_xx.lst, EDM_Training_xx_RepVal_May.lst, and 
EDM_Training_xx_Forecast_June.lst.  

Note: xx = corresponds to your group number 

Select Enter in the Business Document Navigator dialog box that appears. Make a 
note of the directory to which you are exporting the files. 

 

1-1-2 Which fields identify the register during the profile value import? Which values 
are in the file?  
 

Field name Value 
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1-2 In the next step, you will import the profile values for January to April 2001 (file 
EDM_TRAINING_xx.1st). To do this, select the transaction EEDMIMP01.  

Note: This transaction has been created solely for training and testing the import of profile 
values. 

 

1-2-1 Deselect the Use Role field. The Use Role field must not be selected. Select file 
type ASC and enter a description in the External Reference field. Make a note of 
the description: 

 

Choose Execute and confirm the dialog box that appears.  
Open the file EDM_TRAINING_xx.1st (using F4) in the directory that contains 
the files exported in the previous exercise. Choose Enter to start the upload. Read 
the upload log file. 
 
_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-2 In the SAP menu choose Utilities IndustryÆ Energy Data Management Æ 
Monitoring Æ Profile Value Import. Choose the Display Import Log icon. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-3 In the Monitoring Profile Import screen, check that your profile values were 
imported correctly. 
 
_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 
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1-3 Not all profile values for a measured profile are available. As a result, replacement values 
must be created for the profile. 
 

1-3-1 Which methods of replacement value creation do you know?  
 
___________________________________________________________ 
 
___________________________________________________________ 
 

1-3-2 Create a forecast profile using the following data: 

Description: Forecast profile group ##  
Division:  Electricity 
Profile type: Forecast profile 
RVP group:  Manual 
Valid from:  01/01/2001 
Interval length:  15 Minutes 
Profile value category:  Quantity 
Decimal places:  7  
Measurement unit for MR:  kWh 

Make a note of the profile number and the description: 

Save the profile.  
 

1-3-3 Allocate the profile to the register of business partner TP0101A0##. Use the 
Consumption forecast role for the allocation. 
 
___________________________________________________________ 
 
___________________________________________________________ 
 

1-3-4 Import the forecast consumption values for the month of June 2001 from the file 
EDM_Training_xx_Forecast_June.1st. Ensure that the Use Role field is selected. 

Call up profile value import monitoring and check whether there are any profiles 
to be corrected. 
 
___________________________________________________________ 
 
___________________________________________________________ 
 

1-3-5 Correct the profile values for your own profile. 
 
___________________________________________________________ 
 
___________________________________________________________ 
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1-4 Replacement values can also be created automatically. To do this, you must use the 
Replacement Value Procedure Groups in the profile. 

 

1-4-1 Where do you define the Replacement Value Procedure Group in Customizing? 
Read the on-line documentation.  
 
___________________________________________________________ 
 
___________________________________________________________  

 

1-4-2 Change the profile header definition of your historical profile. Select the 
replacement value procedure group EDM Training: Automatic Calculation. Save 
the profile header.  
 
___________________________________________________________ 
 
___________________________________________________________  

 

1-4-3 Import the measured load shape for the month of May 2001 from the file 
EDM_Training_xx_RepVal_May.1st. Ensure that the Use Profile Allocation Role 
field is not selected. 
 
___________________________________________________________ 
 
___________________________________________________________ 

 

1-4-4 Call up the profile value import monitoring and check whether there are any 
profiles to be corrected. Check whether these values have been corrected. 
 
___________________________________________________________ 
 
___________________________________________________________  

 

1-4-5 Display the corrected values from the period 05/05/2001. Which values were 
determined? 
 
___________________________________________________________ 
 
___________________________________________________________ 
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 Solutions 

 

 

Unit: Import Profile Values 
Topic: Import Profile Values 

 

1-1 Proceed as described in the exercise. 

 

1-1-1 Compare the PoD, the unit of measurement, and the register code with the values 
you made a note of in the EDM-Relevant Data Objects exercise. 
 

Field name or data type Values 

Point of delivery DE 123456 69120       EDM_P_0## 

Unit of measurement kWh 

Register code EDM_TRAINING 

 

Close the file. 

Under Text, select the file name and choose the Export Document icon. 

Do this for the following files: 
EDM_TRAINING_xx.lst (profile values January to April) 
EDM_Training_xx_RepVal_May.lst (Values for the replacement value procedure)  
EDM_Training_xx_Forecast_June.lst (values for forecast data). 

Note: xx = Corresponds to your group number 

Select Enter in the Business Document Navigator dialog box. Make a note of the 
directory to which you are exporting the files. 

 

1-1-2 Which fields identify the register during the profile value import? Which values are 
in the file?  
 

Field name Value 

Point of delivery ID DE 123456 69120 EDM_P_0## 

Register code EDM_TRAINING 

Role category 01 (Measurement) 

Role of profile allocation 0001 (Consumption measured)  
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1-2  

 

1-2-1 Proceed as described in the exercise. 

 

1-2-2 In the SAP menu choose Utilities Industry→ Energy Data Management → 
Monitoring → Profile Value Import. Choose the Display Import Log icon. 

 

1-2-3 In the Monitoring Profile Import screen, check to see if your profile values were 
imported correctly. 

You should see your profile number displayed without any errors. 

 

1-3  

 

1-3-1 Which methods of replacement value creation do you know?  

The manual procedure and the automatic procedure.  

 

1-3-2 Create a forecast profile using the data provided in the exercise. 

 

1-3-3 Allocate the profile to the register of business partner TP0101A0##. Use the 
Consumption forecast role for the allocation. 

 

1-3-4 Import the forecast consumption values for the month of June 2001 from the file 
EDM_Training_xx_Forecast_June.1st. Ensure that the Use Role field is selected. 

Call up the profile value import monitoring and check whether there are any 
profiles to be corrected. 
In the SAP menu, choose Utilities Industry→ Energy Data Management → 
Monitoring → Profile Value Import or transaction code EDM1. 
 

Field name Values 

Prof. with RVs (Display profiles with 
replacement values) 

Selected 

 

1-3-5 Correct the profile values for your own profile. 

Select the profile containing the values to be corrected and choose Edit → 
Generate Replacement Values for Profile. 
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1-4  

 

1-4-1 Where do you define the Replacement Value Procedure Group in Customizing? 
Read the on-line documentation.  

In the SAP Reference IMG, choose SAP Utilities → Energy Data Management → 
Profile Management → Replacement Value Creation → Define Replacement 
Value Procedure Group.  

 

1-4-2 Change the profile header definition of your historical profile. Select the 
replacement value procedure group EDM Training: Automatic Calculation. Save 
the profile header.  

 

1-4-3 Import the measured load shape for the month of May 2001 from the file 
EDM_Training_xx_RepVal_May.1st. Ensure that the Use Role field is not 
selected. 

You do this using the transaction EEDMIMP01. 

 

1-4-4 Call up the profile value import monitoring and check whether there are any 
profiles to be corrected. Check whether these values have been corrected. 

In the SAP menu, choose Utilities Industry→ Energy Data Management → 
Monitoring → Profile Value Import or transaction code EDM1. 
 

Field name Values 

Prof. with RVs (Display profiles with 
replacement values) 

Selected 

Succ. RVC (Display profiles with 
successfully replaced values) 

Selected 

 

1-4-5 Display the corrected values from the period 05/05/2001. Which values were 
determined? 

The value 4.9 was determined. The replacement value procedure group EDM 
Training: Replacement Value Group determines up to three missing values during 
the maximum procedure. The last value before the missing values and the first 
value after the missing values are compared, and the higher of the two values 
(maximum) is used as the replacement value. 
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Manage Profile Values: Unit Contents

Profile Values Search and Presentation

Changes to Profile Values and Versioning

OLE Integration
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Manage Profile Values: Unit Objectives

z Select profile values
z Display profile values
z Change profile values
z Make versions for profile values
z Customize profile value statuses
z Use the OLE interface to display and 

change profile values
z Discuss presentation of profile 

values on the Web

At the conclusion of this unit, you will be able to:
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Manage Profile Values: Select and Display Profile 
Values

Select and Display Profile Values

Change Profile Values and Versioning

OLE Integration
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EDM Profile Creation Process
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� The profile creation process within EDM is described in Units 5, 6, 7 and 8 of the IUT225 course. 

� The first step is the creation of the profile header. This was discussed in Unit 5 – Profile Header. The 
second step is Profile Allocation, which was covered in Unit 6 – Profile Allocation. The third step is the 
Import of Profile Values, which was discussed in Unit 7 – Import Profile Values. 

� You can manage the profile values in EDM once you have created the profile header and allocated it to a 
data object in the system, and once the profile values have been imported. 

� In this unit, the Profile Values Management process is discussed. This process tasks such as: 

y Profile values presentation (table or graphical) 

y Modification of profile values 

y Status management 

y Versioning 

y OLE integration (Object Linking and Embedding) 
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� You can select and display profile values using one of the above-mentioned objects. 
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� To access the transactions for displaying and maintaining profile values choose: Energy Data 
Management →  Profile Management →  Profile Values →  Display/Change. 

� You can display profile values in table form or as a graphic. 

� The changeover to summer-time is taken into account in EDM.  
If profile values are managed in 15 minute intervals, you have the following scenario: 

y In Spring there are 4 fewer time intervals on the day of changeover, because 03:00 directly follows 
01:45 (therefore the time intervals 02:00 to 02:45 are missing). 

y In Autumn there are 4 more time intervals on the day of changeover. There are two intervals for 02:00, 
02:15, 02:30 and 02:45.  

� The changeover to other time zones is also taken into account in EDM. 
The database stores all values in Universal Time Coordinated (UTC). When the local system time is set, 
for example to GMT, the system displays the UTC time + 1 hour to show the GMT time.  
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� Once you have selected the profile, three tab pages appear in the work area containing information on 
the profile header, the profile values and the source of the profile values. 
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Profile Values Displayed in EDM: Graphical Format
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� When you display the profile values in a graphic, there are numerous formatting options. Right mouse 
click on the graphic to access the different diagram options. 
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� To access the Change Profile Values transaction in the menu, choose: Energy Data Management → 
Profile Management → Profile Values → Change. 

� You can change values in one of two ways: 

y Single value change 

y Mass change 
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12.04
12.06
11.99
10.00
15.00
20.01
22.04
12.04
11.65

00:00:00
01:00:00
02:00:00
03:00:00
04:00:00
05:00:00
06:00:00
07:00:00
08:00:00
09:00:00
10:00:00
11:00:00

01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000

DayDay Interval timeInterval time StatusStatus Profile valuesProfile values

Changes to Profile Values (Single Value Change)

Single value change

12,04

Original value

 
 
 

� In this example, the profile value on 01.01.2000 was changed manually from 12.05 to 15.00. 

� In doing so the status of the profile value has changed. The new status specifies that the values was 
changed manually. 
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20.00
29.02
21.05
22.04
22.06
21.99
20.00
25.00
30.01
32.04
22.04
11.65

DayDay Interval timeInterval time StatusStatus Profile valuesProfile values

Changes to Profile Values (Mass Change)

Carry Out Mass Change

Operation:

With value:

On fields from:

To:

+

10

01.01.2000 00:00:00

01.01.2000 10:00:00

Mass change

Original value +10

00:00:00
01:00:00
02:00:00
03:00:00
04:00:00
05:00:00
06:00:00
07:00:00
08:00:00
09:00:00
10:00:00

01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000
01.01.2000

11:00:0001.01.2000

 
 
 

� In the Carry Out Mass Change transaction, you can change several profile values at once by making the 
following settings: 

y Operation:  

- Add, subtract, multiply, divide, replace 

- Delete Values, Protect Values, Undo Value Protect, Lock Values, Release Values, Interpolate 
Values, Extrapolate Values 

y With value: Enter the value here that must be used to carry out the mathematical operation (for 
example, add value x to the previous profile values or multiply the previous profile values by value x). 

y To values from and to: You enter the period (date and time) here for which the profile values are to be 
changed. 

� In the above example, a mass change took place for the profile values on January 1st 2000 between 
00:00:00: and 10:00:00, in which the value 10 was added to each of the original profile values. 

� In doing so the status of the profile value has also changed. The new status specifies that the values have 
been manually changed. 
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Customizing the Display for Profile Value Status

Status 
ID

Status 
symbol

Status 
color

Status
priority

Customizing
profile value 

status

 
 
 

� You can define how the status of profile values is displayed in tabular and graphical presentation.  
Make the settings in Customizing under Energy Data Management → Profile Management → Display 
Function → Define Status Display for Profile Values. 

� You define the status display using the following parameters: 

• Status: ID of the status predefined by SAP. 

• Status symbol for tabular presentation: Here you define which symbol is used to display the status of 
a profile value for tabular presentation. You can use the input help function to selection a symbol, or 
you can define your own. 

• Priority of status for tabular and graphical profile presentation: Here you define which status is 
displayed when a profile value has more than one status. You can use the input help function to find 
out the permissible value range for the priority allocation. 

• Color of status for graphical profile presentation: Here you define the color in which the status of a 
profile value is displayed for graphical profile presentation. You can use the input help function to 
find out the color numbers of the red, green and blue values (RGB values). You can use the input help 
function to find out the permissible value range for the color number allocation. 

� For more information, see the General Information on Profile Value Display in Customizing under 
Energy Data Management → Profile Management→ Display Function. 

 

 
                                         

 



 

© SAP AG IUT225 8-14 

 SAP AG 1999

Profile versions

Create version based
on profile type

SETTLEMENT

DATAIMPORT

MANCHANGE

SCHEDULE

Creation reasons
for profile versions

Create version

ALWAYS CREATE

NEVER CREATE

DEMAND IF POSSIBLE

SETTLEMENT RUN

Description

AUTOMATIC DATA IMPORT

MANUAL CHANGE

CREATION OF SCHEDULE

Reason Profile type

HISTORICAL

FORECAST

SCHEDULE

 
 
 

� You can define reasons for creating profile versions.  
To do this you must make the settings in Customizing under Energy Data Management → Profile 
Management → Profile Versions → Define Creation Reasons for Profile Versions. 

� You can also define the creation of a version based on the profile type. You can determine, for example, 
that if the values of an elementary profile type are changed, then a version is always created, and if the 
values of an historical profile type are changed, then a version is never created. 
To do this you must make the settings in Customizing under Energy Data Management → Profile 
Management → Profile Versions → Define Creation of Profile Version. 
Diese Einstellungen kommen nur bei der manuellen ؤnderung von Profilwerten über die Transaktion 
Profilwerte نndern zum Tragen.  
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� If versions of profile values exist, you can display them using the Display/Change Profile Values 
transactions. In doing so, you can display several versions in parallel. 

� You can delete versions. 
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Energy data 
repository 

Archiving Profile Values

Archive repository

Profile header data
(current)

Profile values
(archived)

Archiving
procedure

 
 
 

� You can archive profile values that are no longer required online. Profile values are deleted from the 
database and written to archive files. You can display the archived values. 

� The profile header information remains. On the profile header screen,  the last archiving date can be 
seen. 

� Customizing: 

y Before you start the archiving run for the first time, you must first activate the archive information 
structures for the individual documents (in this case, the document type is EDM profile values). You 
make these settings in Customizing of SAP Utilities → Tools→ Archiving → Activate Info Structure 
for Archiving. 
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Archiving sequence

Archiving period
Defined via a retention-period in the Customizing for Archiving

Analysis of Archivability of Profile Values

ISU_BILLZ ISU_BILL ISU_PROFV

Billing lines Header

Billing documents Profile values

 
 
 

� You want to archive profile values after a certain amount of time (retention period in system). To do this 
you define the retention period of profile values in Customizing under SAP Utilities → Tools 
→ Archiving → Define Retention Period for Archiving Objects.  

� Profile values are analyzed to find out whether they can be archived or not. This analysis is as follows: 

1. Profile value selection: First you must enter the period for which the values are to archived.  
 Enter a profile value that you want to archive. 

2. Determination of the final date for archiving: 
The system determines the final date for archiving from the retention period defined in days in 
Customizing. This means that only those documents that are older than the retention period in 
Customizing can be archived.  
To determine the final date for archiving profile values, the retention period of archiving object 
ISU_BILL (billing document header) is used.  You can only archive the profile values if the billing 
of the associated installation is complete, and the billing document can no longer be reversed. 
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Manage Profile Values: OLE Integration

Change Profile Values and Versioning

OLE Integration

Select and Display Profile Values
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Display Profile Values in EDM Using the OLE 
Interface

Profile header data

Profile values

Status of
profile values

 
 
 

� In addition to the tabular and graphical presentation of profile values within EDM, the values can also be 
displayed and edited in Microsoft Excel using the OLE Interface. This is possible through the SAP 
Office integration. 

� To display the profile values in Microsoft Excel, choose the following: Energy Data Management 
→ Profile Management → Profile Header → Change/Display. 

� Once you have selected a profile, a tab page with an Excel symbol appears in the work area. If you 
choose this tab page, the following data is displayed in an Excel worksheet. 

y Profile header data 

y Profile values 

y Status of profile values 

� EDM is fully integrated with Microsoft Excel. You can use all the standard Excel functions such as 
graphics or macros. 
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Export Profile Values Using the OLE Interface

Profile

z Export Profile Values to Excel

Save as local
*.xls file

 
 
 

� You can export profile values to display, change or save them on your local drive, for example. To do 
this choose Export Profile Values from Excel. 

� Requirements (Import/Export/Display): 

y Microsoft ® Excel 97 

y 128 MB memory 

y > 300 MHz 

y 19“ screen recommended 
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Import Profile Values Using the OLE Interface

z Import profile values
from Excel

Import from
*.xls file

The time period must 
correspond to the 

values to be imported

Before the import, 
the status must be replaced 

by the action that is 
to be executed

 
 
 

� Profile values can be imported back into EDM after the profile has been edited on a local drive. To do 
this choose Import Profile Values to Excel. 

� Before you import the file, you must adjust the entry in the Status or Action column accordingly in the 
Excel file. 

� The following operations are allowed: 

y UI12 Import valid values 

y UI13 Import estimated values 

y UI14 Import missing values 

y UI15 Import doubtful values 

y UI19 Import overlapping values 

� During the import, consistency checks are also run. 

� To save the changes, you must choose File -> Save in the Excel menu.  
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Change Profile Values Using the OLE Interface

z Additional features

Remove
write protection

� Change data using Excel: Formulas, graphical changes, macros, 
...

� Save changed data locally (*.xls)

� Import profiles from Excel

 
 
 

� Note: It is only possible to save the file using the Excel function File -> Save as. 
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Display Profile Values on the Web (1)

 
 
 

� Profile Values can also be displyed on the web. 
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Display Profile Values on the Web (2)
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Exercises 

 

 

Unit: Manage Profile Values 
Topic: Manage Profile Values 

 

At the conclusion of this exercise, you will be able to: 
• Display profile values in both table and graphical format 

• Change profile values (single values and mass changes) 

• Display versions 

• Use OLE to export profile values and import changed profile values 

 

You have maintained the profile values for the period January to June 
2001 for business partner TP0101A0##. You must process these values in 
different ways and display them. 

 

1-1 Display the profile values for business partner TP0101A0##. In the SAP menu, choose 
Utilities IndustryÆ Energy Data Management Æ Profile Management Æ Profile Values 
Æ Display. 

 

1-1-1 In the search area, enter the profile (Prof. tab page) to which you allocated values 
in the previous exercise, or use the business partner TP0101A0## (GP tab page) 
to determine the data. 
Choose 01.01.01 - 31.01.2001 as the selection date. 

 

Display the profile values by selecting the box in the selection area. 
 
_________________________________________________________ 
 
_________________________________________________________ 
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1-2 Display the profile values for the 06.01.2001. 

 

1-2-1 What was the peak value for that day?  
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-2 When did the peak value occur? 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-3 What is the total consumption on 06.01.2001? 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-4 When was January’s peak value (date and time)? 

_________________________________________________________ 

_________________________________________________________ 
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1-3 You can also display the profile values as a graphic. 

 

1-3-1 Display the values for January 2001 for your profile as a graphic. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Zoom into the graph step by step. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Select a calendar week. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-3-2 Show the legend: 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Add a linear trendline: 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Change the line style to a “dashed” line: 
 
_________________________________________________________ 
 
_________________________________________________________ 
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1-4 To change the profile values manually, choose Utilities Industry Æ Energy Data 
Management Æ Profile Management Æ Profile Values Æ Change. 

 

1-4-1 Select the individual profile value that you wish to change and make your 
changes. 
 
_________________________________________________________ 
 
_________________________________________________________ 

Save your entries. 

Choose Yes when asked if you want to create a version for your profile. 

 
_________________________________________________________ 
 

_________________________________________________________ 

 

Monitor the status of the change. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-4-2 For mass changes, choose Carry Out a Mass Change. 
Select the operation (‘+’, ‘-‘, for example) that you wish to carry out. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Enter a value in the With Value field. 

 

Make a selection in the To Values From and To fields. 

Choose Enter. 

Choose Yes when asked if you want to create a version for your profile. 
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1-5 If you want to display the profile values for a version once you have made the changes, 
choose Utilities Industry Æ Energy Data Management Æ Profile Management Æ 
Profile Values Æ Change. 

 

1-5-1 Choose Version. Highlight the rows of the versions that you wish to display. 
(Note: You should have three versions.) 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-5-2 Display the selected versions as a graphic. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-6 If you want to export and change profile values with OLE, choose Utilities Industry Æ 
Energy Data Management Æ Profile Management Æ Profile Header Æ 
Change/Display. 

 

1-6-1 Enter your historic profile for identification. Choose 07.15.01 as the selection 
date. Double-click on the profile in the selection area. Choose the tab page with 
the Excel symbol. Choose Export Value to Excel and select the folder on your 
local hard drive where you want to save the file.  
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-6-2 Open the file on your local PC and make the appropriate changes to the profile 
values. 
 
_________________________________________________________ 
 
_________________________________________________________ 
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1-6-3 Under the Status or Action column, change the status to UI12 (Valid values). 
Make sure that the import time and data in the Profile values area is the same as 
in the Status of profile values area. 
 
_________________________________________________________ 
 
_________________________________________________________ 

Save the data and close the application. 

 

1-6-4 Go back into the SAP system. Choose the Import Profile from Excel pushbutton 
and select the location of your file. Choose Enter. 
 
_________________________________________________________ 
 
_________________________________________________________ 

Save your entries. 

 

1-6-5 Check whether the changes that you made in Excel on your local PC have been 
transferred. 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1. 1-7 You can also maintain profile values using manual extrapolation. 

 

1-7-1 Select your profile for the measured load shape from the table of profile values 
and choose the period from 05.01.2001 to 07.01.2001. 

 

1-7-2 Extrapolate the values from 06.01.2001. How were the values determined? Check 
the values by comparing them with the forecast values. 
 
__________________________________________________________ 
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Solutions 

 

 

Unit: Manage Profile Values 
Topic: Manage Profile Values 

 

1-1  

 

1-1-1 Proceed as described in the exercise. 

 

1-2 Select the value presentation of the profile values for the 06.01.2001. 

Enter the date 06.01.2001 in the Values tab page. Choose Enter or choose Next day until 
you reach the 06.01.2001.  

 

1-2-1 What was the peak value for that day?  
 

Field name Value 

Peak value 12.94 

 

1-2-2 When did the peak value occur? 

Double-click on the peak value. The system specifies the interval in which the 
peak value occurred. 
 

Field name Value 

Interval 17:30 

 

1-2-3 What is the total consumption on 06.01.2001? 

Choose Aggregation to display the total consumption. 
 

Field name Value 

Total consumption 1,005.74 
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1-2-4 When was January’s peak value (date and time)? 

Ensure that the selection date includes a range of one month 
(01.01.2001 – 01.31.2001).  

Select the Maximum value pushbutton. 

Double click on the value to display the date and time. 
 

Field name Values 

Date 13th January 

Time 13:15 
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1-3  

 

1-3-1 Display the values for January 2001 for your profile as a graphic. 

Choose the Display Graphic icon. 

Zoom into the graph step by step. 

Choose Zoom In (magnifying glass with + sign). 

Select a calendar week. 

 

1-3-2 Show the legend: 

Choose the Status Legend icon. 

Add a linear trendline: 

Right click on the values in the graph and choose the Add Trend Line menu 
option. 

Change the line style to a ‘dashed’ line: 

In the Line tab page, choose the dashed line in the Style field. 

 

1-4 Proceed as described in the exercise. 

 

1-5 Proceed as described in the exercise. 

 

 
                                         

 



 

© SAP AG IUT225 8-34 

 

1-6 Proceed as described in the exercise. 

 

1-6-1  

 

1-6-2  

 

1-6-3 Note: The From-Dates and the From-Times in the Profile Value and Status of 
Profile Value sections of the Excel worksheet should be identical. The To-Date in 
the Status of Profile Value section should be the same as the last date in the 
Profile Value section. The To-Time in the Status of Profile Value section should 
be the same as the last interval end time in the Profile Value section. For 
example, if the profile values have been generated for one day, 01.01.2001, the 
Status of the Profile Value section should be as follows: From-Date = 01.01.2001, 
From-Time = 00:00:00, To-Date = 01.01.2001, To-Time = 23:59:59. 

 

1-6-4  

 

1-6-5  

 

1-7 You can also maintain profile values using manual extrapolation. 

 

1-7-1 Select your profile for the measured load shape from the table of profile values 
and choose the period from 01.05.2001 to 01.07.2001. 

Go to 01.06.2001.  
Select the column with the profile values. Choose Carry out a Mass Change.  
In the Operation to be Carried Out field, select the entry Extrapolate Values. 
Enter a reference consumption. 

 

1-7-2 Extrapolate the values from 01.06.2001. How were the values determined? Check 
the values by comparing them with the forecast values. 

The values were copied from the comparison period of the forecast profile in the 
register. You can check the values by displaying both the extrapolated and 
forecast values. 
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Formula Profiles: Unit Contents

Formulas and Formula Profiles

Elements of a Formula Profile

Calculation Workbench
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Formula Profiles: Unit Objectives

z Define formulas and formula profiles
z Describe the use of a formula profile
z Present the elements of a formula profile
z Explain the use of status groups and 

input/output parameters
z Describe formula allocation
z Use the Calculation Workbench 

to calculate formula profiles
z Create and calculate a formula 

profile

At the conclusion of this unit, you will be able to:
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Formula Profiles: Formulas and Formula Profiles

Formulas and Formula Profiles

Elements of a Formula Profile

Calculation Workbench
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What is a Formula Profile?

Historic profile 100 Historic profile 101+ Formula profileFormula profile

 
 
 

� Formula profiles contain values that were determined on the basis of a calculation rule. 

y The calculation rule is mapped in a formula. 

y You can use the formula profiles to map constant dependencies for profiles on a long-term basis. 

� Formula profiles, like all other profiles, are created using the Create Profile  transaction. You must 
choose the Formula profile type in the profile header. You can then the enter the appropriate details that 
are needed for formula profiles. 
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yn = min( x1, x2, xn )

x1

x2

x3

In OutFormula

y1

y2

y3

Definition of the Formula

Profile

Profile

Profile

Profile

Profile

Profile

Function module

Inbound 
profile

Outbound 
profile.

.

.

.

.

.

 
 
 

� A formula is a calculation rule that converts the different input parameters (profile values) into output 
parameters (formula profile values), according to a mathematical algorithm. 

� Formulas: 

y Form the basis of the profile calculation, in which the mathematical dependencies are mapped. Are 
implemented as function modules and allocated in the profile header. 

y Have input and output parameters, the amount and category of which are defined in the formula 
definition. 

y Are delivered by SAP and can be adjusted in Customizing. 

y Are used in the interface for billing. 

 

 

 

 

 

 
                                         

 



 

© SAP AG IUT225 9-6 

 SAP AG 1999

Elementary load profile Formula load profile

Formula Profile Calculations

z Operations involving several profiles

� Addition for each interval

� Subtraction for each interval

� Average value for each interval

� Multiplication with a factor

� Other

LoadLoad
profileprofile

Add / sub .Add / sub . // aveave........
LoadLoad

profileprofile
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Formula SUM01

x1   +   x2

Formula SUM01

Formula SUM01: Example

Historic profile 100

Input parameter: x1

Historic profile 101

Input parameter: x2

Formula profile 102Formula profile 102

Output parameter: y1

SUM01: Add two profiles (quantities)

 
 
 

� Formula: SUM01 - Addition of 2 profiles (quantities) 

y Input parameter 

- Profiles to be added together 

y Output parameters 

- Formula profile that contains the sum of the values from the input parameters 
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Formula Customizing

Define 
header 

data

Define no. of 
input 

parameters

Define no. of 
output
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Allocate 
function 
module 

for formula

Define 
formula 

description

Parameter
number

Parameter
category

Parameter
ID

Profile
values

category

Define 
parameters

Parameter
number

Parameter
category

Parameter
ID

Profile
values
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For each parameter:

 
 
 

� In Customizing, you can define formulas in addition to those that were already predefined by SAP.  

� Customizing path: 

y SAP Utilities -> Tools -> System Modifications -> User-Defined Enhancements for Energy Data 
Management -> Formulas -> Define Formula. 

� Parameter definitions: 

y Parameter number: Defines the number of input and output parameters in the formula. 

y Parameter category: Input or output 

y Parameter ID: Description of formula parameter 

y Profile value category: Classifies values that you manage in the profile. 
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O01 Portion below first baseline

O02 Portion above first baseline

O03 Portion above second baseline

O04 Demand above baseline

BLUE:  OutputI01 Measured load profile

I03 Second baseline value

RED: Input

I02 First baseline value

Formula Example: LIMIT01

 
 
 

� Formula:  LIMIT01 

� Input parameters: 

y I01: Measured load profile: Quantity 

y I02: First baseline value: Quantity 

y I03: Second baseline value: Quantity 

� Output parameters: 

y 001: Portion below first baseline: Quantity 

y 002: Portion above first baseline: Quantity 

y 003: Portion above second baseline: Quantity 

y 004: Demand above baseline: Demand 

� Function module: 

y ISU_EDM_FORMULA_0004 

� Formula description: Value determination above and below a demand baseline. 
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Allocate Allocate 
formulaformula

*Allocate
status
group

Allocate
validity

date

Allocate
input/output
parameters

*Customizable options

EnterEnter
headerheader

datadata

Create Formula Profile: Process 

Tab page details

General profile 
information

 
 
 

� Details 

y Formula (can be displayed using transaction [EEDM08]) 

y Status group 

y Formula allocation 

y Allocation validity 

y No calculation checkbox 

� The details of this process are discussed in the following slides. 

 

 
                                         

 



 

© SAP AG IUT225 9-11 

 SAP AG 2003

Formula Profile: Elements of a Formula Profile

Formulas and Formula Profiles

Elements of a Formula Profile

Calculation Workbench
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Formula
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Output 
parameters

Output 
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Input
parameters

Input
parameters

Status
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Status
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FormulaFormula

Elements of a Formula Profile

 
 
 

� Formula profiles are created using the Create Profile Header transaction [EEDM06] 

� The four most important elements of the formula profile are: 

y Formula 

y Status group 

y Input parameter 

y Output parameter 

� Profiles are allocated to the input and output parameters within the formula profile. 
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Status Groups and Statuses for Status Groups

Status group 1

Status

Priority

Action

Status 1

Priority 1

Action 1

Status 2

Priority 2

Action 2

Status 3

Priority 3

Action 3

 
 
 

� When you create a formula profile using the Create Profile Header transaction, you must allocate the 
status group. Status groups define the status of the input parameters when converted into output 
parameters.  

� Within the status group, the status and priority determine which business process (action) to use. Once 
the status has been determined - with the highest priority for the output parameters of a formula - the 
action allocated to this status is determined and executed.  

� The meaning of the individual status group elements: 

y Status refers to the status of the input parameter (for example, no value, value is valid, value is 
estimated, and so on). 
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Actions and Statuses

Action Description
UI10
UI11
UI12
UI13
UI14
UI15
UI16
UI17
UI18
UI19
UI20
UI21
UI22
UI23

Value changed or entered manually
Release value
Import valid value
Import estimated value
Import missing value
Import implausible value
Estimate value
Lock value
Delete version of value
Import overlapping values
Export value
Remove value protection
Set deletion flag
Set value protection

Status Description
IU010
IU011
IU012
IU013
IU014
IU015
IU016
IU017
IU018

Value not available
Value missing
Value valid
Value was estimated
Value implausible
Value changed/entered manually
Value released
Value locked
Value protected

Allocate
an action

to each status
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Sample Status Group: IMPORT

Input 1

Status: Value is Valid

Input 2

Status: Value was Estimated

Formula profile

Input Profile 1:  
Value 1

Input Profile 1:  
Value 2

Input Profile 2:  
Value 1

Input Profile 2:  
Value 2

Ouput
formula
profile:
Value 1
is valid

+ +

Status group: IMPORT

Results in a 
valid status value

Output
formula
profile:
Value 2
is valid

 
 
 

� In the example above, the formula profile is allocated to the IMPORT status group.  The status groups 
are set up in Customizing.   

� The IMPORT status group contains the following statuses, priorities and actions: 

Status Status Priority Action  

IU012–Value is Valid           1  UI12-Import Valid Value 

IU013–Value was Estimated           2 UI13-Import Estimated Value 

� Because the status ‚Value is Valid‘ has the highest priority, the action ‚Import Valid Value‘ is 
performed. 
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Status group

Define Status Groups and Statuses

Define
status groups

and
statuses

Status for 
status group

 
 
 

� In this Customizing activity, you define and prioritize statuses and actions, and arrange them into status 
groups. Status groups are used in the profile calculation. When the status is determined for the result 
value of a formula, the action with the highest priority of all input parameters is determined. 

� Customizing path: SAP Utilities -> Energy Data Management -> Profile Management -> Formula 
Profiles -> Profile Calculation -> Define Status Group and Statuses for Status Group. 

y Status group description 

y Status for status group 

- Status: Key that informs you of the current status of an object.  

- Status priority: Defines which status of a status group is determined for the result value of a 
formula.  

- Action: Defines which business action is to be executed on the basis of the priority and status 
determination.  

� For more information about Customizing, see the SAP Service Marketplace http://service.sap.com. 
Choose Enter now, and enter your user and password. Then choose Solution Details -> Industry 
Solutions -> mySAP Utilities -> Media Center -> Energy Data Management -> Literature -> Cookbook 
Customizing Interfaces to External Systems.  
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Input and Output Parameters

Profile:
historic, 
price or 
formula 

Formula 
profile

yn = min( x1, x2, xn )

x1

x2

x3

In OutFormula

y1

y2

y3

Profile

Profile

Profile

Profile

Profile

Profile

Function module

.

.

.

.

.

.
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Input parameter

IN 1

Allocation of Profiles to Input and Output 
Parameters

Output parameter

IN 2

OUT

Formula

Formula 
profile

Allocation

Allocation

 
 
 

� For each profile allocated to the input and output parameters in the formula, specify the following 
information: 

y No calculation: If you select this field, the formula allocation is not calculated, although calculation-
triggering events (such as changed profile values) have taken place.  

y No status: If you select this field, the statuses of this input parameter are not taken into account for 
status determination for the values of the output profile (this means the formula profile).  

y Consecutive number 

y Profile number 

y Validity period (from-to) of parameter allocation 
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Formulas with Multiple Output Parameters

Input parameter

IN 1

Output parameter

IN 2

OUT 2

Formula

Allocation

Allocation

OUT 1

OUT 3

Profile 178Profile 178

Profile 205Profile 205

FormulaFormula
profile 210profile 210

FormulaFormula
profile 211profile 211

Formula
profile 212

 
 
 

� When a formula has multiple output parameters, each formula profile must be defined individually for 
the correponding output parameter. This means that a separate profile header is created for each output 
parameter.   

� The above example includes a formula with three output parameters. A separate formula profile is 
allocated to each output parameter. 
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Formula Allocation Number

IN 1

IN 2

OUT 2

Allocation

Allocation

OUT 1

OUT 3

Profile 178Profile 178

Profile 205Profile 205

FormulaFormula
profile 210profile 210

FormulaFormula
profile 211profile 211

Formula
profile 212

All three profiles have 
the same formula 
allocation number
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Formula: 
SUM01

Formula Allocation

Formula allocation: 100Formula allocation: 100

Formula allocation: 101Formula allocation: 101

Formula: 
SUM01

Input 1Input 1

Input 2Input 2

Input 3Input 3

Input 4Input 4

Output 1Output 1

Output 2Output 2

Output 3Output 3

Output 4Output 4

 
 
 

� A formula from the same category can exist more than once in the system. The number of the formula 
allocation is used to differentiate between the individual formulas. 

� In the above example, formula SUM01 is used twice in the system. Formula allocation numbers 100 and 
101 are used for differentiation. 

� When you create a formula profile header, a formula allocation number is automatically generated. 
When there are multiple output parameters defined in the formula, as shown above, you must create a 
formula profile for each output parameter. 

� You can use the input help (F4) function for formula allocation to display all formula allocations that do 
not yet have output parameters, and have the same interval lengths.  
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FormulaFormula
profile 861profile 861

FormulaFormula
profile 858profile 858

Sample Formula with Multiple Output Parameters

Input parameter

Output parameter

Consumption 
profile

Formula COPY01

Copy
consumption 

profile

Copy as 
demand 

value

MeasuredMeasured
consumptionconsumption

profile 823profile 823

Allocation

Allocation

Allocation

When this profile is 
created, a formula 
allocation number 

is generated

Profil: 858 
Formula: COPY01 
Form. allocation: 106
PVal.Cat.: Quantity

Profil: 861 
Formula: COPY01 
Form. allocation: 106
PVal.Cat.: Demand

 
 
 

� In the above example, formula COPY01 is used to copy one profile into two output profiles: 

y Formula COPY01 has an input parameter, to which a consumption profile (load shape) is allocated.  

y Formula COPY01 has 2 output parameters 

- Output parameter 1 is allocated a copy of the consumption profile. 

- Output parameter 2 is allocated a profile, in which the consumption values have been converted into 
demand averages. 
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Dependent Formula Allocations

Formula: SUM01

Formula allocation: 100Formula allocation: 100Input Input 11

Input 2Input 2

Output 1 is used as input for Output 1 is used as input for 
formula allocation 101formula allocation 101

Formula: SUM01

Formula allocation: 101Formula allocation: 101Input 3Input 3

Input 4Input 4

Formula:  LIMIT01

Formula allocation: 102Formula allocation: 102Input 5Input 5

Input 6Input 6
Output 3Output 3

Output 2 is used as input for Output 2 is used as input for 
formula allocation 102formula allocation 102

Output 2Output 2

Output Output 11

 
 
 

� You can create complex formula allocation hierarchies that are taken into account in the formula 
calculation. The calculation mechanism takes into account lower-level formula allocations in the 
hierarchy when higher-level allocations are flagged for calculation by the calculation-triggering events. 

� You can use the Calculation Workbench to present formula allocation hierarchies in a graphic. 
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Formula Profiles: Calculation Workbench

Formulas and Formula Profiles

Elements of a Formula Profile

Calculation Workbench
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EDM Calculation Workbench

Calculation trigger

Asynchronous
calculation

Process formula
allocation

Current
calculation run

 
 
 

� To call up the Calculation Workbench, choose Utilities Industry -> Energy Data Management -> 
Automatic Profile Calculation -> Calculation Workbench. 

� The Calculation Workbench is the gateway to calculating, processing and monitoring formula profile 
calculations. It includes the following: 

y Process formula allocation 

y Calculation trigger 

y Asynchronous calculation 

y Current calculation run 
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Process Formula Allocation

Formula
allocation
process

Display
formula 

allocation

Calculate
formula 

allocations

Hierarchy
display

Flag for 
calculation

 
 
 

� Process formula allocation 

y Display formula allocation shows the allocation via the Display profile header screen. 

y Using Calculate formula allocation (synchronous calculation), you can calculate a formula allocation 
synchronously for a certain period. This also includes all inactive, dependent formula allocations with 
triggering functions.    

y Flag for calculation: Generates a calculation trigger. 

y Hierarchy display: Allows the user to see the formula allocation in a graphic, to better understand the 
relation between the profiles. 

y To and From Date (time slices are calculated at the same time). 
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Process Formula Allocation: Display Hierarchy

Input Parameter 
Measured 

Consumption 
Profile 823

Formula COPY01 
Formula Profile 858 is 
assigned to the first 

Output Parameter

Formula Profile 861 is
assigned to the second 

Output Parameter

 
 
 

� Users are able to see the Profiles assigned to the particular Formula Allocation by selecting the ‚Display 
Hierarchy‘ pushbutton within the Calculation Workbench. 

� For example, take the sample discussed earlier for Formula COPY01.  Note the information entered in 
the Profile Header screen and how it looks in this hierarchical representation. 
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Synchronous Asynchronous

Æ A * B = C

Æ C + A = D

Formula Calculation

Æ A * B = C

Æ C + A = D

 
 
 

� Asynchronous Calculation: Formula profile calculation analyzes the dependent formula allocations 
based on the compressed calculation triggers, and starts parellel calculation of the profiles. 

y It is executed in the background on the specified servers as many times as the number of jobs you 
have selected per server. 

y It is performed on several servers and processors per server for optimum system performance 

y It is locked for other users while a calculation run is taking place. If a calculation run has not been 
successfully completed, the lock is not removed from the calculation run. When monitoring the 
calculation, you can remove the lock and restart the calculation run. 

  Note:  As a prerequisite for the profile calculation, you must compress the calculation trigger 
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Select calculator 
(synchronous calculation)

Enter formula allocation

Synchronous Formula Calculation

Enter calculation dates

Select calculator 
(calculate formula allocation)

 
 
 

� Synchronous Calculation: The immediate calculation of the formula profile - triggered by the user. 

y Enter the formula allocation and choose Calculate Formula Allocation. 

y Selected formula allocation and all inactive formula allocations beneath it in the hierarchy are 
calculated. 

y This allows the user to make single formula calculations. 

y Allows calculation of a single formula profile allocation within a dependent formula. 

� When the Calculator pushbutton is selected from the Calculation Workbench, the Calculation Status for 
Formula Profiles: Details screen is shown. 

y The To and From dates are entered. 

y The status of the calculation is displayed. 

� The log is displayed once the calculation is over. It contains messages indicating whether the calculation 
was executed successfully or with errors. 

� After the profile has been calculated, in the profile header, Details tab page, you can see the calculated-
to date, which shows the last date the formula was calculated. 
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Asynchronous Formula Calculation

Scheduled
calculations

Trigger 

FormulaFormula
allocationallocation

Flagged for Flagged for 
CalculationCalculation

101

102

103

104

105

106

107

108

x

x

x

x

x

 
 
 

� Asynchronous Calculation is the scheduled calculation of formula profiles. The calculation run takes 
into account all formula allocations, for which calculation triggers exist. 

y Choose the Schedule Calculation pushbutton in the Calculation Workbench. 

y Schedule Calculation Run starts the calculation run. 

y Unlock is used to unlock calculations with errors. 

� Note: Parallel processing of the scheduled calculation runs is possible.   
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Calculation Trigger

Unlock Monitor

Compress

Calculation 
trigger

 
 
 

� The calculation trigger must be compressed to run the formula calculations. 

� Because only completed formula allocations and not individual profiles are calculated, the temporary 
triggers are compressed at the level of the total formula allocation. Compression of the calculation 
trigger is a prerequisite for asynchronous calculation of formula allocation. 

� The calculation triggers are compressed with regard to the formula allocation number, and the from- and 
to-date.  

� To calculate formula allocations that are connected as regards time and hierarchy in parallel, without 
causing locks, the data must first be put into an appropriate form as regards time and hierarchy. 

� Unlock Compression: The compression is locked while the calculation trigger is being compressed, so 
that no other compression can be started at the same time. If errors occur during the process, 
compression remains to locked. You can, however, remove the lock manually. 

� Monitoring calculation triggers:  Allows user to monitor the compression. 
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Current
calculation

run

Current Calculation Run

Status

Parallel
processing

Calculation errors

Action log

Job overview

Refresh

 
 
 

� The Current Calculation Run dialog box displays information about the current calculation run. 

y Header data: 

- Calculation run number, Restart number, Create dates, User ID for creator 

y Status: Monitor status on the run, or manually change the status of the calculation run. 

y Parallel processing 

- Interval length or number of intervals, server name and number of jobs 

y For more information about the calculation run, see the Calculation Errors, Job Overview and Action 
log pushbuttons. 
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Exercises 

 

 

Unit: Formula Profiles 
Topic: Formula Profiles 

 

At the conclusion of this exercise, you will be able to: 

• Create a formula profile 

• Run the calculation workbench 

 

Formula profiles contain values that are determined on the basis of a 
calculation rule. The calculation rule is a formula that converts the 
different input parameters into output parameters, according to a 
mathematical algorithm.  

 

1-1 Create a formula profile.  
To create a formula profile you must first create a profile with a profile type that refers to 
the Formula Profile category. In the SAP menu choose Utilities Industry→ Energy Data 
Management → Profile Management → Profile Header → Create. 

 

1-1-1 Create a formula profile for the electricity division and use formula profile group 
0## as the profile name. 

 

1-1-2 In the General tab page, select the following entries in the Profile Data group 
frame: 
Profile type: Formula profile 
Valid from: 01.01.2001 
Valid to:  31.12.9999 

In the Value Data group frame select the following entries: 
PV category:  QUANTITY  
MeasUnit for MR:  kWh 
Interval length:  15 Minutes 
Decimal places:  7 
 
_________________________________________________________ 
 
_________________________________________________________ 
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1-1-3 Choose the Details tab page and enter the following data: 
Formula: LIMIT01  
Status group: All values → Valid 
From-date: 01.01.2001 
 
_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-1-4 For the input and output parameters, allocate the third output parameter (Portion 
above first limit). 

Double click on input parameter 01 Measured value. 

Choose  Create Allocation and allocate the measured profile for your group 
number. 

Allocate profile 25 to the First Limit Value as Quantity. 

Allocate profile 50 to the Second Limit Value as Quantity. 

Choose Enter. (Note: Make a note of your formula allocation number). 
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1-2 Perform synchronous calculation for the formula allocation that you have just created. 
Choose the calculation workbench from the SAP menu under Utilities Industry → Energy 
Data Management → Profile Calculation → Calculation Workbench. 

Note: 
You can also choose  Hierarchy Display to view your formula allocation as a graphic. 

 

1-2-1 Enter the formula allocation number. Enter the calculation dates 01.01.2001 to 
31/01/2001. Choose  Calculate Formula Allocation. 
You reach the Calculation Status for Formula Profiles: Details screen. Either 
select the lines with the formula allocation that is to be calculated, or enter a 
period (for which the calculation is to be executed) in the Restrict Synchronous 
Formula Calculation group frame, and choose  Synchronous Calculation. 
 
_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-2-3 Display the log. 

_________________________________________________________ 

_________________________________________________________ 

_________________________________________________________ 
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1-3 Display the formula profile values from 01.01.2001 to 31.01.2001.  

 

1-3-1 Display the results. The input data is defined as follows in the formula profile: 
 

Description Values 

Measured profile Your measured profile 

1. profile 25 kWh 

2. profile 50 kWh 

Output profile Portion above first limit 

 

What was the first occurrence of a value that is above the first limit?  

_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

What are the date, time and value of the result?  
 
_________________________________________________________ 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

Can you explain the results for this interval? 
 
_________________________________________________________ 
 
_________________________________________________________ 

 

1-4 Additional exercise: Allocate multiple output parameters to the formula allocation. 

 

1-4-1 Allocate other output parameters to the formula profile that you created earlier.  
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Solutions 

 

 

Unit: Formula Profiles 
Topic: Formula Profiles 

 

1-1 Proceed as described in the exercise.  

 

1-2 Perform synchronous calculation for the formula allocation that you have just created. 

 

1-2-1 Proceed as described in the exercise.  

 

1-2-3 Proceed as described in the exercise.  
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1-3 Display the formula profile values from 01.01.2001 to 31.01.2001.  
In the SAP menu, choose Utilities Industry→ Energy Data Management → Profile 
Management → Profile Values → Display. 

 

1-3-1 Enter the formula profile and 01.01.2001 – 31.01.2001 as the selection date for 
the calculation. 

What was the first occurrence of a value that is above the first limit? 

What are the date, time and value of the result?  
 

Field name or data type Values 

Value 2.04 

Date 10.01.2001 

Time 06:45:00 

 

Can you explain the results for this interval? 

The output profile created from the formula allocation was allocated to the 
Portion above first limit output parameter.  Since the first limit value is 25, all 
values from the measured profile that are above 25 will result in output values 
from the formula calculation.  In other words, values above the limit of 25 are 
calculated as follows:  
Measured value – Limit value = Output result. 
The formula calculation for this interval leads to this result because on 
10.01.2001 at 06:45:00, the profile value in the measured profile is   
27.04  –  25  =  2.04 

 

1-4 Additional exercise: Allocate multiple output parameters to the formula allocation. 

 

1-4-1 Proceed as follows: 

Create the profile header for the second output parameter but this time, enter the 
formula allocation number from step one in the Formula Allocation field. 
Note: You can use the Possible Entries function (F4) to find the formula 
allocation. 
Choose Enter 
Click the Expand All pushbutton to display the allocation of the profile to the 
output parameter. 
To allocate more output parameters, follow these steps again until all output 
parameters have been allocated. 

Choose Enter. 
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Synthetic Profiles: Unit Contents

Definition and Use of a Synthetic Profile

Synthetic Profile Structure

Generation of Synthetic Profile

Allocating a Synthetic Profile
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Synthetic Profiles: Unit Objectives

z Describe the difference between standard 
load profiles and synthetic profiles.

z Define season, day and time of use (TOU) 
types and groups.

z Generate synthetic profiles
z Adjust and standardize synthetic 

profiles
z Explain the function of the usage factor.
z Allocate profiles to an installation

At the conclusion of this unit, you will be able to:
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Synthetic Profiles: Definition and Use of Synthetic 
Profiles

Definition and Use of Synthetic Profile

Synthetic Profile Structure

Creating a Synthetic Profile

Allocating a Synthetic Profile
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� Synthetic profiles (Standard load profiles) are used in some energy markets if customer consumption is 
not determined using an interval reading. 

� In Germany, for example, the German Electricity Association (VDEW) has a number of different 
customer groups. In the USA, customers are grouped together based on their consumption patterns. In 
order to do this, interval meters are installed at a representative customer from each group for a specific 
period of time. Overall consumption patterns are then calculated using these sample measurements. 
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Synthetic Profiles (II)

Profile

SyntheticSynthetic profileprofile

Day group 
1 ... n

Season group 
1 ... n

 
 
 

� A Synthetic Profile is a profile that contains values generated on the basis of predefined periods 
(defined by day and season groups) and corresponding day and annual profiles. It is used when no 
interval readings are available to classify the consumption patterns of groups of customers. Customers 
groups (those customers with similar consumption patterns) are assigned the same synthetic profile.  

� Two further characteristics of a synthetic profile that will be discussed in this unit are: 

y Dynamic modification factors 

y Usage factors 
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Synthetic Profiles: Synthetic Profile Structure

Definition and Use of Synthetic Profile

Synthetic Profile Structure

Creating a Synthetic Profile

Allocating a Synthetic Profile
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Synthetic Profile Structure

00:00                  24:00

Day profile A

00:00                  24:00

00:00                  24:00

Weekday

00:00                  24:00

Weekend

Residential Residential 
customercustomer

Summer

Weekday

Weekend

Winter

Day profile

Synthetic profileSynthetic profile

Day group 
1 ... n

Season group 
1 ... n

Day profile B

Day profile C

Day profile D

 
 
 

� Synthetic profiles can be made up of hierarchy structures. Components within this hierarchy are: 

y Season Groups 

y Day Groups 

y Profiles 

� You can adjust season groups, day and time-of-use groups in Customizing: SAP Utilities -> Energy 
Data Management -> Basic Settings 

� You must establish day, season and TOU settings before you can generate synthetic profiles.   

� Note: These settings are also required in the RTP-Interface where they define the structure of RTP 
components. This will be covered in detail in IUT 235: Real-Time-Pricing.  
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Customizable Season Types and Season Groups

Season type Description Consec. no. Start End
0001 Summer 1 Jan 4 Sept 30

0002 Winter 11 Jan 10 Dec 31

0002 Winter 22 Jan 01 Mar 31

0003 Year without divisions 1 Jan 01 Dec 31

Profile

Synthetic Synthetic 
profileprofile

Day group 
1 ... n

Season group 
1 ... n

A season type cannot be defined over the change 
of a year, for example, winter = 10/01/ - 03/31; the 
same season type, however, can be be allocated 
to two season periods with consecutive numbers.

Season periods per season 
group must add up to one 
year

Season group 1

Season group 2

 
 
 

� Season types describe a recurring period within a year. Season periods are allocated to a season type.  In 
the example above, the following Season Types have been customized: 

y Season type Summer (0001) describes the season period from 04/01 to 09/30. 

y Season type Winter (0002) describes the season period from 01/01 to 12/31. (Consecutive number 
1) and the period from 01/01 to 03/31. (consecutive number 2).  

� Season groups describe the division of the year into season types. 

y The season periods allocated to the season types in the season group must total one year (01/01 to 
12/31) and cannot overlap. 

y For example, to divide a year into summer and winter, define a season group that contains the season 
types summer (to which you allocate the season period 04/01 to 09/30)and winter (to which you 
allocate the season periods 10/01 to 12/31 and 01/01 to 03/31). 
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Day group 1

Day group 2

Customizable Day Types and Day Groups

Day type Description Factory calendar ID Working day

0001 Weekday 01 X

0002 Weekday 01

0003 All days 01 X

Public holiday

X

X

Profile

Synthetic Synthetic 
profileprofile

Day group 
1 ... n

Season group 
1 ... n

 
 
 

� Day types define days based on the factory calendar. 

y In the Factory Calendar, Monday through Friday are defined as working days and Saturday, Sunday, 
and public holidays are defined as non-working or weekend days. A factory calendar is based on a 
public holiday calendar. 

y In the example above, the week is divided into weekdays and weekend days and the following 
customized day types are defined: 

- Weekday with reference to the workdays in factory calendar 01, this means Monday through 
Friday. 

- Weekend with reference to the public holidays in factory calendar 01, this means Saturday, Sunday, 
and public holidays. 

- Other day types can also be customized. 

� Day groups contain different day types. 

y Day group 1 includes weekdays (day type 0001) and weekends (day type 0002). 

y Day group 2 includes all days (day type 0003). 

� Note: If different day types are defined based on different factory calendars, all of the factory calendars 
must refer to the same public holiday calendars. 
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Customizable TOU Types and TOU Groups

Time-of-
use type Description Consecutive 

number Start End

0001 On-peak 1 08:00:00 17:59:59

0002 Off-peak 1 00:00:00 07:59:59

0002 Off-peak 2 18:00:00 23:59:59

TOU Periods per TOU Group 
must equal one day

TOU Group 1

TOU Group 1: On-off-peak

TOU Type 1: On-peak

TOU Type 2: Off-peak

 
 
 

� Time of Use Groups consist of Time of Use Types.  

� Time of Use Types are defined and assigned to a Time of Use Group.  For example: 

y The TOU period from 08:00:00 to 17:59:59 is allocated to TOU type 0001 (on-peak rate period) 

y TOU periods from 00:00:00 to 07:59:59 and 18:00:00 to 23:59:59 are allocated to TOU type 0002 
(off-peak rate period) 

� In order to set up the TOU Group, the Time of Use Types On-Peak and Off-Peak are allocated to a 
TOU Group.  In the above example, TOU Group On-Off Peak consists of on- and off-peak time 
periods as defined in the TOU type. 
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Su 03/28 Mo. 03/29          Tu 03/30          We 03/31        Th 04/01   Fr 04/02 Sa 04/03         Su 04.04 Mo 04/05          Tu 04/06

Winter Summer

Working day Working day Working dayWeekendWeekend

Day profile 
102

Day profile 
101

Day profile 
103

Day profile 
104

Day profile 
103

Generation of Synthetic Profile

 
 
 

� Synthetic profile values are determined using reference measurements or statistical methods and are 
saved as a day profile in the Energy Data Repository. 

� Based on the allocation of season, day and TOU groups, a synthetic profile structure is generated. 

� During the generation of the synthetic profile, the day profiles (standard load profiles) are determined 
according to the hierarchy. The profile values are then transferred to the synthetic profile according to 
the hierarchy settings. 

 

 
                                         

 



 

© SAP AG IUT225 10-12 

 SAP AG 2003

Synthetic Profiles: Creating a Synthetic Profile

Definition and Use of Synthetic Profile

Synthetic Profile Structure

Creating a Synthetic Profile

Allocating a Synthetic Profile
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Winter WinterTransitionTransition Summer

In a synthetic profile 
without dynamic 
modification, you can 
clearly see the gaps at 
the transition points 
between time zones.

Dynamic modification 
adjusts the load shape to 
seasonal characteristics.

Dynamic Modification Factor

Winter WinterTransitionTransition Summer

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov

 
 
 

� Dynamic Modification Factors are used to modify a customer or customer group's synthetic profile to 
represent the temperature impacts throughout the year. This process is known as dynamic modification 
and guarantees a typically stable load shape.   

� Dynamic modification factors are generated in EDM.  

� Note: SAP delivers a dynamic modification function. This function complies with the standards of the 
German Electricity Association (VDEW).  

� You can find this function in Customizing under SAP Utilities -> Tools -> System Modifications -> 
User-Defined Enhancements for Energy Data Management -> Dynamic Modification Function for 
Synthetic Profiles -> Define Functions for Calculating Dynamic Modification Factors. 
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Jan. Feb. Mar. Apr. May June July Aug. Sep. Oct. Nov. Dec.

Norming

1000 kWh

Not normed

 
 
 

� Synthetic profile values can be normed in relation to a given consumption amount, or a fixed reference 
value, for a given time period of time.  In this way a total consumption is used to create a synthetic 
profile based on the day profiles attached to it. 

� Normalization is possible for one year or one month. You can norm a synthetic profile for a year, for 
example, where the sum of the values is 1000 kWh (reference value) over the period. 

� Note: Values can only be generated for a period many times greater than the period length for norming. 

� In the example above, the synthetic profile is normed at 1000 kWh per year.   
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Synthetic Profiles: Allocating a Synthetic Profile

Definition and Use of Synthetic Profile

Synthetic Profile Structure

Creating a Synthetic Profile

Allocating a Synthetic Profile
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Allocating a Synthetic Profile

Business
partner

Contract
account

Contract

Connection 
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Device
location

Connection 
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Installation Installation Synthetic profileSynthetic profile
0 .. 0 .. n (time)n (time)

Usage factor 
1 (time)

 
 
 

� Synthetic profiles are allocated to the installation via roles.  

� Different synthetic profiles can be allocated to one installation. 

y For example, synthetic profiles can be used in both billing and settlements.  

 

 
                                         

 



 

© SAP AG IUT225 10-17 

 SAP AG 1999

Determination of consumption 
from customer consumption = 

900 kWh

Th                Fr                Sa                Su Mo               Tu                We             Th               Fr                Sa Jan 1, 2001

Summer

Weekday

Summer

Weekday

Winter

Weekday

Winter

Weekday

Winter

Weekday

Winter

Weekday

Winter

Weekday

Summer

Weekend

Winter

Weekend

Summer

Weekend

Synthetic 
profile for 
customer 

group

Usage Factor 

Dec 31, 2001

Normed at 1000 kWh per year

Usage factor =
Customer consumption

Normed profile consumption
= 900 kWh

1000 kWh
= 0.9

 
 
 

� The usage factor represents the relationship between customer consumption and normed consumption 
values from the synthetic load profile.  

� In the example above, the synthetic profile is normed at 1000 kWh. The actual consumption of the 
customer is 900 kWh. The usage factor is automatically determined by dividing the customer 
consumption by the normed value of the synthetic profile.  

y Usage Factor = 900 kWh / 1000 kWh = 0.9 

� Usage factor is updated 

y Usage factors are automatically calculated and updated via consumption quantity determination in IS-
U Billing. The billing period in which the consumption accumulates is taken into consideration. It is 
possible to specify for each synthetic profile of the installation whether the consumption quantity 
determination updates the usage factor or not. 

 

 

 
                                         

 



 

© SAP AG IUT225 10-18 

 SAP AG 2003

Choose Choose CreateCreate

Allocating a Profile to an Installation

z Technical Master Data -> Installation -> Change

Search forSearch for
InstallationInstallation

ChooseChoose
Load ProfileLoad Profile

Enter aEnter a
valid datevalid date

Enter theEnter the
load profileload profile

Enter Enter 
usageusage
factorfactor

Save data

Note: You can also allocate a profile allocation role

 
 
 

� Select Load Profile in the Installation -> Create or Change transaction 

� Choose Create 

� Enter a start and end validity date for the allocation 

� Enter the load profile to be allocated 

� Enter the usage factor 
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Exercises 

 

 

Unit: Synthetic Profile 
Topic: Create a Synthetic Profile 

 

At the conclusion of this exercise, you will be able to: 

• Create a synthetic profile 

• Generate profile values 

• Allocate a synthetic profile to an installation 

• Display the profile values of a synthetic profile 

 

 

A synthetic profile must be defined for the installation belonging to 
business partner TP0101A0##. In order to do this, you must create a new 
profile header and generate values for it. 

 

 

1-1 Create a synthetic profile. 

 

1-1-1 Enter the profile description synthetic load profile group ###. 
Select the division electricity and enter the following data in the tab page general: 

Profile type:  Synthetic Profile 
Valid From and Valid To: 01.01.2000, 31.12.9999 
Interval length: 15 Minutes 
Profile value category: QUANTITY  
MeasUnit for MR: Quantity 
Decimal places: 7 

Save the profile. Make a note of the profile number: 

_______________ 
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1-1-2 Enter the following details on the Details tab page: 

Season groups: 0003 (year divided into summer, winter, trans)  
Day group: Day Group: 0003 (Weekdays, Saturdays, Sundays) 
Norming: Normed for one year 
Reference Value: 1000 
Dynamic modification factors: Profile 118 

In the Generate or Display Profile Values box, enter From Date 01/01/2000 and 
To Date 31/01/2001. 

Allocate day profiles to the corresponding season and day groups using the chart 
below. Select the day group and choose  Create Allocation. 
 

Day profile Working day Saturday Sunday 

Summer 105 103 104 

Winter 102 100 101 

Transition 108 106 107 

 

1-2 Generate the profile values. 

The synthetic profile created above was normed for one year. You must, therefore, 
generate profile values for a year. 

 

Optional step: 

1-2-1 You can select the tab page with the Excel symbol and view the profile values you 
have just generated 

 

1-3 Allocate the load profile you have just created to the installation TP0101A0##.  

 

1-4 Display the profile values from 01.01.2001 to 31.12.2001 for the synthetic profile created 
in the previous exercise. 
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Solutions 

 

 

Unit: Synthetic Profile 
Topic: Create a Synthetic Profile 

 

1-1 Create a synthetic profile. Choose from the SAP menu Utilities Industry→ Energy Data 
Management → Profile Management → Profile Header → Create. 

 

1-1-1 Proceed as described in the exercise. 

 

1-1-2 Proceed as described in the exercise.  

 

1-2 Generate the profile values. 

The synthetic profile created above was normed for one year. You must, therefore, 
generate profile values for a year. In the Generate or Display Profile Values box, enter 
From Date 01/01/2000 and To Date 31/01/2001. 

Choose  Generate Profile Values. 
The status of the profile values generated will appear yellow 
Save your entries.  
The profile value status is now green. 
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1-3 Allocate the load profile you have just created to the installation TP0101A0##.  
Go to the SAP Menu and choose Utilities Industry → Technical Master Data → 
Installation → Change.  

Enter the installation. 
 

Field name Values 

Installation  TP0101A0## 

Choose  Load Profile. This takes you to the Load Profile initial screen. In the Allocate 
Load Profile box, choose  Create. 

Enter a usage factor: 
 

Field name Values 

Usage factor 1.1 

Enter the synthetic profile created in the previous exercise in the load profile field: 

Select a role from the profile allocation. 

Choose Enter. Note that the usage factor and status that you entered manually 
automatically appear in the Load Profile Factor box. This box is updated whenever a new 
usage factor is entered - manually or automatically - via billing 

 

1-4 Display the profile values from 01.01.2001 to 31.12.2001 for the synthetic profile created 
in the previous exercise. 

In the SAP menu choose Utilities Industry→ Energy Data Management → Profile 
Management → Profile Values → Change. 

Enter the number of the synthetic profile you created in the previous exercise. 

Enter the selection date 01/01/2001 to 31/12/2001 and choose Enter. The profile is 
displayed in the navigation area.  

Select the field next to the profile. Profile values are displayed in the work area. You can 
view the profiles in table form or as a graphic. 

Note:  
You can view different profiles simultaneously in both table form and as graphics. To do 
this, enter the profile number in the profile field. Choose enter and, in the navigation area, 
select the field next to each profile you want to view. 
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